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Welcome to ConceptDraw.

Welcome to ConceptDraw - the program for creating business and technical
drawings developed by Computer Systems Odessa Corp.

Powerful Tools.

ConceptDraw offers you a wide choice of different tools you can use for quickly
creating business diagrams, thorough research layouts, schemes, plans, etc.
For each object you can assign different line colors, fill colors, fill and shadow
patterns. Any object may contain text. The Snap and Glue tools help you align
points, lines and objects as you draw them and position them precisely.

Formulas allow you to define various object parameters, which gives you virtually
unlimited control over objects.

ConceptDraw’s intelligent connectors automatically change their path when
you reposition objects, avoiding crossing other objects. And what is more, you
can turn any object into a connector.

Connectors let you easily create all kinds of charts: technological or business
processes, organization schemes, program project plans, etc.

OLE (Object Linking and Embedding) compatibility means that a ConceptDraw
document can be edited within any other OLE-compatible application (for
instance, MS Word). And vice versa, any file or document, created in another
OLE-compatible program can be embedded into ConceptDraw.

The Import/Export capabilities let you easily use images stored in files of
different formats.

The program provides you with extended Internet capabilities: creating and using
hyperlinks, sending documents by e-mail, saving a document in HTML format.
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It's easy.

You don’t need to have any artistic talent or drawing skills to use this program.
Simpler objects can be easily created by using simple graphic segments and the
Snap tool, and for more complicated ones you can use our Libraries, supplied
with the program, where most of the objects you might need are already gathered
for you, and can be easily dragged from there and dropped into your document.
Connectors allow you to join objects together and keep them connected even
if you reposition the objects.

Key Features.

»  Complete cross-platform compatibility between the Windows and MacOS
versions of ConceptDraw. All documents, templates and libraries can be opened
as on a Mac as on a PC without conversion.

+  Supports basic elementary segments: line, arc of circle, arc of elli pse, spline.

+ Basic segments can be combined into one object.

» Text can be associated with objects:

» Text size and angle can be changed separately of the object.
Various text styles are available.
+  Extended formatting options are supported.
+ Extended object properties:
+  More than 30 fill patterns. Gradient fill patterns.
+  Color shadows are supported.
+  More than 60 arrowhead styles.
Various object properties can be locked against changes.
+  Changeable double-click action of objects.
» Adding, multiple selecting, moving, deleting of handles.
» Advanced operations on objects:
+  Grouping, ungrouping, editing group.
+ Rotating objects, including images.
+  Vertical/Horizontal fli pping.
+  The Snap function adds maximum precision to your work.
+  The Glue functionality lets maintain objects connected to each
other.
Various tools for aligning object with respect to each other
and to a guide line.
»  Connectors:
«  When you move objects, connectors reshape accordingly.
+  User-controlled points of connection.

»  Document:

»  Working with multiple pages: adding, deleting, renaming pages.

ConceptDraw 9



»  Zooming in on and out from pages.
»  Changeable scaling in the document. Standard scales are
supported.
+  Metric and non-metric units of measure are supported.
+ The grid, the rulers and the guide lines help you to create
accurate drawings.
«  Working with layers is supported: locking, hiding/showing,
changing the layer colors.
+  User-defined color palette.
+  All your work settings can be saved in a workspace file, letting
you quickly resume working.
Exporting/Importing of the following graphic formats: Windows bitmap,
metafile, JPEG, GIF, PICT, EPS.
Working with the Internet: creating and using hyperlinks, sending
documents via e-mail, saving in the HTML format, searching the Internet.
Object parameter table, where any parameter can be changed or
specified. Formulas can be used to define various object parameters.
More than 60 functions supported.
More than 50 supplied document templates for all occasions.
Over 80 supplied libraries (about 1700 objects).
Object Linking and Embedding (OLE) compatibility.

System requirements.

To install and work with ConceptDraw, your system must have the following

10

configuration:

PC computer:

+ Pentium processor or better;

* 16 MB of RAM or more;

+ CDROM

*  SVGA monitor, 256 colors (16-bit color reccommended);

Windows 95/98/NT /2000 system or higher.

Macintosh computer:

» Power PC processor or better;

* 32 MBof RAM (64 MB recommended);

+ CDROM

«  800x600 resolution, 256 colors monitor (16-bit color reccommended);

MacOS version 8.0 or higher.
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Installing ConceptDraw.

On a Windows system:

L. Insert your ConceptDraw disk in the CD ROM drive;

2 Run Setup.exe from the disk;

3. Follow the instructions that appear on your screen.

4. During the installation process, all necessary files will be copied on your
hard drive. The submenu for ConceptDraw will be created in the Start menu.
The setup program will also place the ConceptDraw icon on your desktop.

On a MacOS system:

L. Insert the ConceptDraw disk into your CD ROM drive.

2 Run ConceptDraw Installer from the disk.

3. During the installation process, all necessary files will be copied on your
hard drive.

Technical support.

We are always ready to answer your questions, which may arise when you’re
working with ConceptDraw. We offer you free technical support - if you couldn’t
find answer to your question in the manual.

The best way to get support is to do this is via electronic mail. Our email
technical support works 24 hours a day, 7 days a week. When reporting a problem,
please include the following information:
+ Registration number you receive with your copy of the product.
»  ConceptDraw version number
+ Information describing your computer: processor type, amount of RAM,
the video adaptor info (make, resolution, number of colors);
 Your operating system version number.
» Adetailed description of how to reproduce the problem.

Send this information via e-mail at support@conceptdraw.com and we’ll do our
best to resolve the problem, or answer your question. Replies usually arrive
within one business day.

More information about our support programs can be found on the ConceptDraw
site http://www.conceptdraw.com. This site is fully dedicated ConceptDraw, and
is a perfect source for latest information about the program, newer versions,
updates, add-on components, training and some other resources that you
can’t get in a printed way. Please check it out regularly to get new libraries,
samples and other useful things.
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Reqistration.

To become a registered user, you have to fill out the registration form on

our site here: http://www.conceptdraw.com/Register/

Registration give you the following benefits:

« all registered users get free technical support.

+ registration entitles you to receive notification about product updates,
add-on components, and other special offers by e-mail.

« discounts for later versions of the product.

Don’t forget to register your copy!

The Team.

12

ConceptDraw was created by a large team of professionals: programmers,
designers, mathematicians, testers, and many other people. They worked hard
to provide you with a high quality product, to make it powerful, beautiful and
easy-to-use. All these people work for Computer Systems Odessa.

Computer Systems Odessa is an international corporation, which has been
developing and publishing software products of various kinds since 1993. The
headquarters of the company are located in the Eastern Europe (the Ukraine),
in the wonderful city of Odessa, on the Black Sea coast.

Here you may see the map:
http://www.cs-odessa.com.ua/corporateinfo/im/mapeuro.jpg

And here, get acquainted with our city - Odessa:
http://www.cs-odessa.com.ua/odessa/odessa.html

Our team always keeps up with our customers’ needs creating high quality
state-of-the-art products. We are always happy to hear your feedbacks and
suggestions which do help us improve our products, stimulating us to use
cuting-edge technologies for creating up-to-date software which helps you to
reach the desired results in your work.

For more detailed information about Computer Systems Odessa, the products
and the team, visit the company site at http://www.cs-odessa.com.ua
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Chapter 1 Working with files

ConceptDraw works with its own file types: document, template, library, work-
space. Besides that, the Import/Export functions let you work with data in files
created by other applications.

i In the Windows version, native ConceptDraw files
have the following extensions: document - cdd;
template - cdt; library - cdl; workspace - cdw.

Creating a new document

From the File menu choose New/Document. A blank document window opens.
D | You can click the New button on the toolbar.

M Ctri+N El Cmd+N

Note: Each new document is based on the Blank Drawing.cdt template file
(stored in the Libraries folder). By reconfiguring this template you can modify
the defaults for every new document. For more info on how to set new document
properties, refer to the "Program Configuration” section.

Creating a new document from @
template

A template includes a document with all its settings (scale, grid, measurement
system, etc.) and a list of libraries, needed for working with the document.
When you create a new document from a template, the program creates a copy
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of the document and opens all the libraries, listed in the template file. You work
with the copy, while the original document remains intact. Using templates
helps you to the focus on the work itself instead of setting up the document
page and opening all the required libraries each time.

Templates are especially helpful when several documents must have common
basic elements (company Logo, standard header, etc).

To create a new document from a template:

Choice one:

L.
2
3

4
5

Choose New/Browse Templates form the File menu to get the Open dialog.
In the dialog, use the upper box to navigate to the desired folder.

In the main box, open the folder where the file resides by double-
clicking the folder.

Select a ConceptDraw Template file.

Click Open.

Choice Two:

L.
2
3

4
5
6

On the File menu, click Open, to get the Open dialog.

In the dialog, use the upper box to navigate to the desired folder.

In the box, double-click on folders to open them until you open the
folder where your file is stored.

In the File of Type box, choose ConceptDraw Template Files (*.cdt)
Select the template you want

Click Open.

E’“| To call the Open dialog

click the Open button on the toolbar.

3l Ctl+O Kl Cmd+0O

Creating a new library

14

Library is a set of ConceptDraw objects gathered together. Their icons or names
are displayed in a special window from where they can be copied into the
document, or another library.

To create a new library file: on the File menu, select New Library.
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Note: You can create a new library using the context
menu when the library window is open. Call the menu
over the library title bar and choose New.

This creates a new empty library, to which you can then add objects from open
documents. Don't forget to save the library after you finished working with it.

Opening a document

To open an existing document:

L. On the File menu, click Open.

2 In the dialog, use the upper box to navigate to the desired folder.

3. Inthe box, double-click on folders to open them until you open the
folder where your file is stored.

4. Select the document file you want to open.

5. Click the Open button.

u You can use the Open button on the Standard toolbar.
L=+
You can also select one of the four documents you last
opened or saved, listed on the File menu.

4l Cm+O K] Cmd+0O

Opening a library

To open an existing library:

1. Choose Open Library from the File menu.

2 In the dialog, use the upper box to navigate to the desired folder.

3. In the box, double-click on folders to open them, until you open the
folder where your file is stored.

5. Select the library file you want to open.

6. Click the Open button.

M You can also use the Open Library button on the
Standard toolbar. If the library window is open,
position the pointer over the library title bar, call the
context menu, and choose Open from the menu.
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Opening documents and libraries using
the workspace

In a workspace file, the program stores a list of open documents and libraries,
along with their on-screen arrangement. This allows you to customize your
work environment only once and use it repeatedly.

To open a workspace file:

L.
2
3

4
5
6

On the File menu, click Open.

In the dialog, use the upper box to navigate to the desired folder.

In the box, double-click on folders to open them, until you open the
folder where your file is stored.

In the File of Type box, choose ConceptDraw Workspace Files (*.cdw)
Select the workspace file you want to open.

Click Open.

Closing a document

On the File menu, click Close.

Saving a document (Save, Save As, Save
As Copy)

To save a document:

On the File menu, click Save. If you're saving the document for the first time,
the Save As dialog box opens. If you have already saved the document before,
your changes will be saved under the previous filename.

16

To save a document under a new filename:

L

2
3

Click Save As (Save Copy As) on the File menu. The Save As dialog
opens.

Type the document is filename in the corresponding field.

In the upper box, choose the drive(volume) and the folder in which
you want to store the file.

Click Save.

E | You can also use the Save button on the toolbar.
il Ctrl+S Bl Cmd+S
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Save As also renames the current document. Save
Copy As doesn't change its title

Creatfing a template file

1. Click Save As Template on the File menu. The Save As dialog opens.
2 In the dialog, use the upper box to navigate to the desired folder.

3. Type the template filename in the corresponding field.

4. Click Save.

The document with all its settings and the list of all opened libraries is now
saved in the template file.

Saving a workspace file

If necessary, save all open documents and libraries.

Click Save Workspace on the File menu. The Save As dialog opens.
In the dialog, use the upper box to navigate to the desired folder.
Type the workspace filename in the corresponding field.

Click Save.

All information about currently opened documents, libraries, their window
sizes and other is now saved in the workspace file.

Using the Start dialog to create/open

documents

The Start dialog will appear each time you launch the program. It offers the
choice of creating a new empty document (the Blank Document option), basing
a new document on a template (the Templates option), and opening an existing
document (the Open File option).

You can select one by clicking on it with the mouse.

If you prefer ConceptDraw to start without seeing this screen, you can
disable the dialog. Click on the check box at the bottom of the dialog,
marked "Don't show this screen again" so a check mark is placed there.
Later, the Start dialog can be reactivated in the Preferences dialog (Edit/
Preferences), Default tab.

Sending a document by e-mail

1. Click Send on the File menu.
2. Ifthe document contains some unsaved changes, the program will ask
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you to save them. Then the e-mail message window appears, with the
document attached to the message.

In the mail client, you'll have to attach the document
file to the message, using the appropriate means of the
mailer.

Importing files

ConceptDraw allows you to import files of the following formats:

e &

bmp — Windows bitmap bmp — Windows bitmap
jpg — JPEG format ipg — JPEG format

gif — GIF format gif — GIF format

pct — MacOS picture format  pct — MacOS picture format
wmf — Windows metafile emf — Enhanced metafile

emf — Enhanced metadfile

18

To import a file:

L. Choose Import on the File menu to call the Open dialog box.
2 Choose the drive(volume) and folder where the file resides.
3. Select the image file.

4. Click Open.

A new document will be created. The picture from the imported file will be
inserted in the centre of the active window of this document.

You can see the contents of the file in the Preview
window of the Open File dialog.

For more specifics about inserting and working with
different image formats please refer to the "Pictures”
section.

= The default setting for the File of Type box is "All
supported formats”. If there are too many files in the
Jolder, you may choose the format you want in this box.
Then the main box will only show files of this format.
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Exporting files

ConceptDraw lets you save your document in one of the following formats:

bmp — Windows bitmap
jog — JPEG format

gif — GIF format

emf — Enhanced metdfile
eps — Encapsulated Post-

Script format
htm — HTML file

4]

bmp — Windows bitmap
jog — JPEG format

gif — GIF format

emf — Enhanced metafile
pct — MacOS picture format
eps — Encapsulated Post-

Script format
htm — HTML file

To export to one of the supported formats:

1. On the File menu, click Export. The SaveAs dialog box will open.

2 Choose drive(volume) and folder in which you want to store the file.
3. Inthe lower box choose the file format you want.

4. Click Save.

‘When exporting to a picture format, the picture properties dialog will come up.

Picture Froperties
_ Image Size
i Original Size () Fitto Size
[JUseZoom 200 | X |200
— Format — Objects
(3 BrLevel () Selected
i) 16 Color i All on page
i 256 Color i Whole page
@) 16M Color

ConceptDraw
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In the Image Size section you can switch between two options:

1. Original Size: If the Use Zoom option is checked, the objects in the
export file will be the same size they appear onscreen. If this option
isn't checked, the objects will be saved in their original size, regardless
of the currently set zooming.

2 Fitto Size: here you can assign custom dimensions in pixels for the picture.

The Format area is only accessible when exporting to BMP. Here you can adjust
color depth for the image.

When exporting to JPEG, you can specify image quality. By using the slide bar,
you can set the quality within 1% to 100% range. Note, that better quality
increases the file size. So the default value is 75%.

In the Object section you specify what objects will form the image in the file:

L Selected - all selected on the page.

2 All on page - all objects on the page and outside it. The image size will
be large enough to fit all objects.

3. Whole page - all objects within the page. The image size will equal
the page size.

When exporitng to EPS format, in the Page(s) to Export area you can specify
which pages of the document you want to be generated in the eps file. Ctrl(Cmd)
or Shift can be used for multiple selection.

Exporting to HTML

20

When you export to HTML, the program brings up the HTML Properties
dialog:

At the Save Picture As area you can specify the picture format for the HTML
file. You can choose GIF or JPEG. GIF images take up less space, so GIF is
set by default. However, if a document contains many colors (over 256), JPEG
is preferable. For JPEG images the user can set picture quality (from 1% to
100%). Note that higher quality means larger picture size.

The Objects section allows to choose which objects to use for generating the
HTML file:

Whole page - exports the whole page. The resulting HTML page gets the same
dimensions as the document page.

All - exports all objects on the page. The size of the HTML page is determined
by the number of the objects and their arrangement.
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Selected - exports selected objects only.
Original Size: With Use Zoom set to on, the resulting image will be the same
size as it looks onscreen. With Use Zoom off, all objects will keep their

original size, regardless of currently set zooming.

Fit To Size: Enter width and height in pixels to make the image the size you want.

Background: Sets background color. When you click this button, the Choose
Color dialog will come up, where you can choose a background color by
clicking on the matching color box. You can change the set of colors if that in
the dialog doesn't suit you (see the "Color Palette" section).

HTML Properties

Cancel I

— Save picture as — Objects
) GIF format {71 Selected
3 JPEG fiormiat @ Al
Cuality
Quality =75 (4 Whaie page
— Image Size
@ Original Size {7 Fit to Size (pixels)
[] Use Zoom l200 | X [200
Background: [| |]
— Hyper Links
[ Object's Hyperlink [ Prev/Mext Fage Links
Page(s) 1o export:
Page-1 il
Page-2 =
< [

Hyperlinks section describes how hyperlinks behave in the HTML file.

Object's HyperLink: If this option is on, hyperlinks assigned to objects will be
accessible in the HTML file.
Prev/Next Page Links: This option sets whether to display buttons for the

ConceptDraw
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previous/next page in a multi-page HTML document. You may disable this
option if you can move through the pages using object hyperlinks. Then ensure
that Object's HyperLink is enabled.

In the Page(s) to Export area you can specify which exactly pages of the document
will be converted in HTML.For multiple selections, Ctrl(Cmd) or Shift keys
can be used.
Click OK to start the conversion. When it's finished, the results dialog shows the
list of generated files. You may click Preview to see the newly created HTML
pages in an available Internet browser.
Ifthere’s any text in the Description field of the
objects you export to HTML, this text will display as
a hint in the browser when the mouse is paused over
such object’s image on the HTML page (see
Properties of objects - Information).
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Chapter 2 Objects

There are the following object types in ConceptDraw: figures, connectors,
groups, pictures and OLE objects.

Figure is the main type of object. Figures consist of elementary segments. There
are four types of segments: LineTo, SectorTo, ArcTo, SplineTo.

Connected segments form a solid path called Geometry. If the beginning of
the first segment coincides with the end of the last one, the geometry becomes
closed and is filled by default.
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A figure may contain several geometries, so it may look like a group of several
objects. But unlike objects within a group, all geometries that form a figure
always have same properties (line style, fill color, etc.). A group of objects may
include objects that have different line styles, different fill colors, etc.

ConceptDraw also lets you create and work with special objects, such as con-
nectors, pictures, and OLE objects. Connectors can be created by means of the
program, pictures and OLE objects are imported from other programs or files.

Connector: Connects two objects together. Its distinguishing feature is that the
connection maintains even if objects are repositioned, resized, etc.

There are two methods for connecting: to the entire object, or to a connection
point of an object. See Connectors for more detailed information.

Group: A group is composed of two or more objects. You can work with a group
like you work with a single object. If needed, you can edit objects that form a group.
For advanced editing options, you can open the Edit group window. For simpler
editing, like modifying the object text, color and some other properties you just
have to select the object within a group. See Grouping Objects for details.

Picture: The following image formats are supported: raster formats (Windows
bitmap - bmp, JPEG - jpg), and vector formats (Windows metafile - wmf,
enhanced metafile - emf, MacOS picture - pct). Objects of this type allow for
limited editing only (rotating, resizing, etc.). See Pictures for more information.

OLE Object: ConceptDraw supports Object Linking and Embedding capabilities
(is an OLE-compatible program). This feature allows you to insert into Concept-
Draw objects, created in other programs. In ConceptDraw, OLE-objects can be
resized, but for full editing the application in which the object was created should
be used. You can find out more in the Working with other programs (OLE) section.

= OLE Objects are only supported by the Windows version.
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Creating Figures.

To create a new figure you may choose from the toolbar one of the following
tools: Line, Sector, Arc, or Spline.

Then using a mouse you draw a segment. To add another segment to it, start
drawing from one of the endpoints of the already existing one. This will lengthen
the geometry of the figure. If you start drawing a segment at any position with
Ctrl (Cmd) held down, this segment will be assigned to the currently selected
object, starting a new geometry. So, the object will consist of two (or more)
separate geometries, but it's still one object.

Ifyou hold down the Shift key when drawing, constrained drawing mode switches on.
The way in which constrained segments behave depends on the segment type.

Lets describe the basic segments:

v | LineTo: is a linear segment. It can be created with
the Line tool . To constrain a line to any 45-degree
angle, hold down the Shift key as you drag.

Ctrl+3

E ArcTo: is a segment of circle. It can be created with
the Sector tool . The direction in which you first drag
the mouse determines which way the curve bows. The
point where you release the mouse button defines the
other end point of the sector. To change the direction
in which the curve bows, hold down the Shift key when
you drag.

Cirl+4
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EllipseTo: is an elliptical quarter-arc segment. Use
the Arc tool to create it.

Ctrl+5

Spline To: is a smooth curve (also called
spline). It can be created with the Spline tool.
This tool works like a pencil on paper, the only
difference is that the curve results smooth rather
than jagged. Once drawn, the spline is easy to
modify by adjusting its vertices and adjustment
handles.

Cirl+6

Besides single segments you can also draw some widely-used complex figures:
rectangle, ellipse, text.Use the corresponding toolbar buttons for each of them.

Rectangle: creates a filled rectangle. Drag the mouse
fo change its size. By holding down the Shift key as
you draw, you constrain the rectangle fo a square.

Ctrl+7

Ellipse: draws a filled ellipse. Drag the mouse to
change its size. By holding down the Shift key as you
drag, you constrain the ellipse to a circle.

Ctrl+8

Edit Text: creates a text box. Drag the mouse to change
its size. If you are holding down the Shift key as you
drag, the text box results in a square. After you release
the mouse button, the Edit Text mode switches on.

F2
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Working with handles

Handles are small square or round controls, which appear when you select an object.

You can select handles of the objects and manipulate them.Selected handles
appear in magenta. To select a handle, click on it with the mouse. You can
select more than one by holding down the Shift key as you click.

You can reposition selected handles with the mouse or Arrow Keys, thus
modifying the relevant aspects of the objects - such as position, size, shape
and so on.

By dragging handles, you can alter some properties of an object like its size, proportions
and other. There are a few handle types, which differ by their functionalitiy.

Resize handles. Resize handles look like small square boxes, usually green or
blue. To resize an object retaining its proportions, drag any of its four corner
handles. To resize a side of the object, drag the appropriate side handle.
More information about resizing objects can be found in the Resizing Objects
section.

D__ _______
)
|
)
1
|
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|
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Rotation handles. Rotation handles look like round corner handles, usually
green or blue. When you drag them, the object rotates around its rotation
centre:

>
€8
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The rotation centre is also a handle, and can be repositioned by dragging it and
moving in whatever direction. More information about resizing objects can be
found in the Rotating objects section.

Endpoints. All 1D objects have the begin point and the end point, called endpoints.

By dragging an endpoint, you resize and rotate an object. Besides, endpoints
have the ability of gluing to connection points of other objects, so all 1D
objects can be regarded as connectors as well. To learn more about connectors,
see the Connectors section.

Vertices and adjustment handles. A vertex is a small diamond-shaped handle, that
appears in the point where two segments meet. By dragging a vertex, you change
the form of an object.

Adjustment handles have a different effect, depending on the type of segment
on which they appear. A linear segment can be transformed in the sector of a
circle by dragging its adjustment handles with the Sector or Arc tool. For a
sector of a circle, the adjustment handles change its curve. For an elliptical arc
segment, they adjust the angle and the magnitude of arc's eccentricity. For a
spline segment, adjustment handles come associated with vertices. By dragging
these handles, you alter the curvature of spline sections near the appropriate
vertices.

For the first three segments, you can transform one into another mani pulating
the handles, for instance, by dragging the adjustment handle of a line with the
Sector or Arc tool, you change it into a sector of a circle, then resize it in an
elliptical arc segment, and vice versa.
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For more information about elementary segments, refer to the Creating
Figures section.

Unlike other handles, vertices and adjustment handles allow some additional
operations on them, besides simply moving. Both vertices and adjustment handles
can be selected and deleted. You can also add new vertices.

To select/unselect a vertex or an adjustment handle, click on it. To select more
than one, hold the Shift key down as you point and click on each additional
handle. The selected handles turn magenta.

Now any operation on handles will affect all the selected handles simultaneously.

Ifyou select a vertex and reposition it with the Shift key held down, its movement
will be constrained. The vertex will move strictly along the line coming out of
the preceding vertex at any 45 degree angle.

If the Right Shift key is pressed, the movement will be
constrained with respect to the following vertex.

To delete selected vertices, use the Del key. Deleting a handle deletes the segment
with which the handle is associated.

Adding a verfex can be regarded as adding a new segment, or even a new geometry
in some cases. For more information refer to Inserting vertices.

Control handles. Control handles are property of library objects. You cannot
create or delete them other than from the table. To move them, use the mouse
exactly as you do with regular handles.

As a rule, each control handle is responsible for a certain characteristic of the
object on which it appears. For example, on the picture below dragging the
control point adjusts the size of the circle's sector:
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Control handles can glue to other objects, the way the endpoints of
connectors can.

Connection points. Connection points indicate locations on objects, where end-
points of connectors can be glued. They look like blue x signs that appear on an
object, or near it.

Connection points can be created, moved and deleted with the Connection
Point tool. For more information, see the Connection Points section.

Any handle can be selected and more than one can be moved at the same time.
However, this works differently with the mouse and keyboard. With the mouse,
only handles of the same type as the one you carry are affected. That is, if you
drag a rotation handle, all the selected rotation handles will move along, but
the selected resize handles will stay in place. With the arrow keys, you move all
the selected handles simultaneously (the response of each hanlde will depend
on its type).

Selecting objects

To work with an object you must select it. Selected objects are surrounded by a
dashed line.
30 ConceptDraw



When you select an object, it also shows handles. Handle is a small control
you can drag to modify some properties of an object. Handles vary with the
type of object and the tool selected on the toolbar. Here you can see how
an ellipse looks with various tools: Select, Line, Arc.

To select an object, click it. If the Select, Rotate or Insert Vertex tool is on, you
can also use Select Box for selecting. Click your mouse beyond all the objects
you want to select, and while holding the mouse button, drag across the objects.
All objects touched by the resulting dashed-line box will be selected.

You can assign primary selection to an object by simply clicking it with the mouse.

O--- B

@

To select all objects on the page, choose Select All
from the Edit menu. To cancel the selection, click

away firom the selected objects.
il Ctrl+A Kl Cmd+A

Multiple objects can also be selected by clicking them one at atime when
holding down the Shift key. To cancel selection of an object when there are
several selected, hold down the Shift key and click the object (this applies to
Select Box as well).

There are two types of selected objects: the object you selected first displays
green handles (primary object), all the rest have blue handles. Some operations
use the difference between primary objects and other objects. Those like Align
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Figures, Distribute Figures, Make Same and some other use the primary object
as a pattern for the others. Others, like Information, Hyperlink, Edit Text work
with the primary object only, and ignore the rest.

mﬂ
-

[;3 | In most cases, the Select tool is used for selecting
objects. To choose, click its button on the foolbar.

B Cirl+1 K] Enter

Selecting objects within a group.
You can select objects in a group like you select other objects.

Unlike common objects, objects selected within a group display grey handles.
This indicates that objects that form a group are protected against some
operations, such as moving and rotating, though you can change their line
color and thickness, fill color, add text, etc.

To select an object within a group, select the group first, and then click the
object you want. If the group includes other groups, you may have to click
more then once until you select the object you want.

Selecting objects in the order they were created.

Another option for selecting is to use the Tab key. Each time you hit Tab,
you activate objects in the order in which they were created or dropped on
page, starting from the currently selected object. The program will adjust the
document page each time you press Tab, so that the selected object results in
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the centre of the screen. If no object is selected, hitting Tab will affect the first
object you've drawn or dropped on the page.
Holding down the Shift key when hitting Tab reverses the selection order.

Smart Selection

When in this mode, the program remembers which objects were selected the
last time (if more than one) and lets you restore the entire selection by clicking
on any of these objects.

This mode can be toggled on/off by checking Smart Selection on Miscellaneous
tab of the Preferences dialog.

Moving objects

Only selected objects can be moved. You can use the keyboard or the mouse
for moving objects.

Moving objects with the keyboard: Moving objects by with the Arrow keys helps
you position objects more precisely. Pressing an arrow key moves the object by
one screen pixel with each keystroke. For more precise positioning, use the
zooming option. The more you zoom in on your drawing, the greater the precision.

Make sure there're no handles selected on the object
before you start moving it with the keyboard, otherwise
you'll move the handles instead of the object itself.

Moving objects with the mouse: It may vary depending on the tool which is
currently on. When you see the pointer change into a black arrow over an object,
it means that you may move the object.

With tools such as Select, Rotate, Rectangle, Ellipse, Insert Vertex, you can
move an object by dragging either its body or the Alignment Box.

k| & Ol o 1

With tools such as Line, Sector, Arc, Spline, Connector, you can move an
object by dragging its Alignment box only.

21 B 5 5=l =
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‘When moving an object with the mouse you only see its outline. In case you'd
like to see the whole object stop the mouse and wait for a second - the object
will appear in full detail.

To constrain the movement of an object to strictly vertical or horizontal, hold
down the Shift key while you drag the object, or use the Arrow keys.

You can protect an object from being moved
horizontally or vertically. This can be done from the
Protect Dialog box. To access the dialog, click on
Protection under the Format menu. In the dialog, check
X Position for the horizontal movement and Y Position
Jor the vertical. By checking both of them you lock the
object against repositioning.

Sometimes you may want to position an object right in the centre of a page. To
do this, first select the object and then perform the Centre Page command
under the Tools menu. With the Centre Vertically and Centre Horizontally
commands you can centre object(s) vertically and horizontally respectively.

The way objects behave when moved is also determined by whether the Snap
tool is on or off. If snapping is on, the object you are moving jumps to the
nearest snap locations (usually the grid nodes), instead of following the mouse
directly. This functionality lets you easily align objects with respect to the grid
lines, guides and other elements. Please refer to the Snapping and gluing section
for more extended description of this feature.

To align objects to one another the following tools are used: AlignFigures and
DistributeFigures.

Align Figures

These tools align the alignment boxes of two or more selected objects.
The object with the primary selection (the one that displays green handles) is the

|E Horizontal alignment on e Vertical alignment
a the left sides on the tops
IEI Horizontal alignment on BHe Vertical alignment
the centres on the centres
= Horizontal alignment on ol Vertical alignment
al |  the right sides = on the bottoms
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object to which other objects align. There are 6 types of alignment: 3 types for the
horizontal (on the left sides, on the centres, on the right sides) and 3 for the
vertical (on the tops, on the centres, on the bottoms).

Here's an example of aligning objects on their left sides:

Distribute Figures

Use these tools to create an equal distance between the alignment boxes of
three or more objects.

Distribute Vertical

4 I:I I;. Distribute Horizontal B
Spacing o Spacing
Distribute Left —o | Distribute Top
P oy
Distribute Centre &= Distribute Middle
G G
1:|E| Distribute Right o= | Distribute Bottom
-

The objects are distributed with respect to the primary object (the one that
displays green handles). There are 8 distribution varienties:

For horizonal distribution - Distribute Horizontal Spacing (creates a uniform
space between the alignment boxes), Distribute Left (between the left edges of
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the alignment boxes), Distribute Centre (between the centres of the objects),
Distribute Right (between the right edges of the alignment boxes);
For vertical distribution - Distribute Vertical Spacing (creates a uniform space
between the alignment boxes), Distribute Top (between the top edges of the
alignment boxes), Distribute Middle (between the centres of the objects), Dis-
tribute Bottom (between the bottom edges of the alignment boxes).

Here's an example of how the Distribute Vertical Spacing tool works:

.

i

Rotating objects

36
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Selected objects can be rotated with the Rotate tool.
By dragging a rotation handle, you rotate the object

around its rotation centre.

You can switch from any drawing tool fo the Rotate tool
and vice versa by clicking the alignment box of the object.

The rotation centre looks like a plus sign in a circle. You can reposition it by
dragging it with the mouse.

Objects can be rotated with the keyboard:

E |

Ctrl+LeftArrow
Ctrd+RightArrow
Ctrl+Shift+1 eftArrow
Ctr+Shift+RightArrow

K

Cmd-+LeftArrow
Cmd+RightArrow
Cmd+Shift+LeftArrow
Cmd-+Shift+RightArmow

counterclockwise by 1 degree
clockwise by 1 degree
counterclockwise by 0.1 degree
clockwise by 0.1 degree
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By dragging the handle farther out from the object, you decrease the increment
of rotation from 30 degree to 0.1 degree, and this way increase the accuracy. The
angle of rotation on degrees appears in the status bar at the bottom of the screen.

If several objects are selected, you may rotate each of them separately, by drag-
ging a rotation handle of an object. If you start dragging with the Ctrl (Cmd) key
held down, all objects rotate simultaneously around their common rotation centre.

- To rotate objects by 90 degrees, use Rotate Left or
b Rotate Right buttons on the standard toolbar or select
+ I Figure/Rotate Left(90), Figure/Rotate Right(90).
=

i Cirl+L E] Cmd+L
Ctl+R Cmd+R

You can prevent an object from rotating and its rotation
centre fiom repositioning. To do this, check Rotate in
the Protect dialog box under the Format menu. Then
the object will display grey padlocks in place of rotation
handles and the rotation centre, indicating that you can't
perform the action.

Resizing objects
Like most other operations, sizing is only possible for selected objects.

You may size objects proportionally (the height and width of the object retain
their proportions ) and unproportionally - change the width or height only.
Use corner handles to resize objects proportionally, and side handles to resize
that side only.
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You can resize objects in either ways with the following
tools: Select, Rectangle, Arc. With the Rotate tool, you
can only resize objects unproportionally. If the snapping
is on, the handle you drag will jump automatically into
the nearest snap location (usually a grid node).

Objects can be resized either with the mouse or the keyboard - in the latter
case you resize an object by moving the selected resize handle. To select a
handle, click on it with the mouse so it turns magenta.

As you resize, the status bar at the bottom of the window registers how the width

and height change.

Holding down the Shift key while dragging a handle reverses its resize action - a
side handles resizes the object proportionally, and a corner handle
unproportionally.

If you need to resize a few objects at a time, there are two methods for doing so:
you may group the objects (menu Figure/Group), resize the group with the
mouse and then ungroup it back (menu Figure/Ungroup); or you may hold
down Shift and click the relevant resize handles on the objects to select them, and
then resize all of them using the mouse or the keyboard.

You may lock an object against resizing in the Protect
dialog box. Click Protection on the Format menu to bring
the dialog up. Check the options you want: Width (to
prohibit width alteration), Height (to prohibit height
alteration) and Aspect Ratio (allows to resize proportion-
ally only). Locked handles will appear as grey padlocks,

indicating that they can't be worked with.
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1t'’s possible to hide resize handles so they don't appear
on the object. To do this, uncheck Show Figure Handles
in the Behaviour dialog box (click on Behaviour under
the Format menu to bring up the dialog).

Unproportional resizing may also alter the type of a
segment. For instance, you can change an ArcTo segment
into EllipseTo by altering its width or height.

How objects behave within a group.

When resizing a group, some programs may cause objects change their internal
angles, in case of unproportional resizing. In such programs, if you change the
height of a group that includes an angled rectangle, the operation transforms
the rectangle into a parallelogram. In some cases this may be inconvenient.
ConceptDraw doesn't have such drawback, and resizing will never transform a
rectangle into parallelogram.

You can set how an object behaves within a group
when the group changes its size. The Behaviour Dialog
allows you to choose one of the following 3 options:
-Scale With Group - always change the size of the object
as the group § size changes.

-Reposition Only - move the object without changing its
size.

-Use Group's Settings - use the settings of the group to
which the object belongs. This setting is default.

Make Same...

Sometimes you may need to make one or more objects same size as some
other object, that acts as a pattern. The Make Same tools (Make Same Width,
Make Same Height , Make Same Size) will help you do this.

HOH Make Same Make Same
- Width Size
DE Make Same

x Height
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Select the pattern object first so that it displays green handles, and then the
objects which size you want to change. Use the Make Same tools to equalize
their width, height or both.

Here is an example of how the Make Same Width tool works:

Fit To Text

Sometimes you may need to make an object the same size as the text it holds.
This can be done with the Fit To Text tool, which shrinks or enlarges a
selected object so it matches the size of its text box.

This tool
L s <

ESRariia-
o e ]
text's size
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Flipping objects

Flipping can be applied to selected objects and changes the direction the
objects face.Use the Flip Vertical and Flip Horizontal items under the
Figure menu, or the Flip Vertical/Flip Horizontal buttons on the toolbar.

=1 Flip Vertical Tool
=1
Flip Horizontal Tool
Ab,
3l Chl+J K] Cmd+J
Ctrl+H Cmd+H

These operations transpose opposite sides of an object with respect to an imaginary
horizontal or vertical line that goes through the rotation centre of the object.

If several objects are selected, the imaginary line goes through their common
rotation centre.

28 &€
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Changing the order in which objects
are displayed

Each time you draw an object, or take it from another document or from a
library and drop on the page, the object gets registered in the order list.
ConceptDraw displays objects according to their position in the order list, so
the most recent objects may overlap the ones you created earlier.

Sometimes you may want to change the display order of an object. Use the
following operations to move selected objects along the order list:

SendToBack - sends the object to the back of the order list. Select Figure/

SendToBack.

48 Ctrl+B Kl Cmd+B

BringToFront - bring the object to the front of the order list. Select Figure/

BringToFront.

gl Cirl+F Bl Cmd+F
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SendToStepBack - positions the object one step lower in the order list. Select
Figure/SendToStepBack.

: kR

) Chl+Shift+B B Cmd+Shift+B

BringToStepFront - positions the object one step higher in the order list.
Select Figure/BringToStepFront.

B

4 Ctrl+Shift+F B Crd+Shift+F

Deleting objects

You can delete objects from a document by selecting them and then pressing
the Del or Delete key. The Delete command under the Edit menu has the
same effect. Check there are no handles selected on the object. If there are any
(selected handles appear in magenta), you'll delete the handles instead of
the object.
You can lock objects to protect them from deleting in
the Protection dialog box (Format menu/Protect).
Check "From Deletion" in this dialog. Then the
program will respond with a warning message each
time you attempt to delete the object.

To delete objects within a group, you ll have to switch
to the Edit Group mode first.
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Duplicafing objects

To duplicate a selected object, select Duplicate under the Edit menu. A copy
will appear slightly below and to the right from the original object.

il Chl+D Bl Cmd+D

Alternatively, you can duplicate objects with the mouse. You may find this
more convenient, for it lets you create a copy and carry it into place with a
single action. Hold down the Ctrl (Option) key and drag a copy out of the
selected object to the place where you want to position it.

R

To copy objects into another document or info a
library, use the Copy/ Paste operations.

Alternatively, you can duplicate objects with the Stamp
Tool. If there's no object selected in the library, this
tool will clone the selected object(s) in the document.
See the Stamp Tool section for more details.

Grouping objects

44

ConceptDraw lets you group several objects so they act like a single object. The
resulting group has its alignment box, and such operations as resizing, rotating
and repositioning affect all objects in the group at once.

To group several objects, select them and choose Group under the Figure
menu. To ungroup the selected groups, choose Ungroup under the Figure
men.

4 Cr+G El Cmd+G
Ctrl+U Cmd+U
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Some operations may have a specific effects when applied to a group. For
instance, you may set resizing to simply reposition all objects within a group.
Or sometimes resizing may affect objects differently depending on how they
are positioned in a group. For more specific information please refer to the
Resizing objects section.

A group doesn't have its own text. When you select a group and start typing
text, it belongs to the frontmost object in the group.

Even when grouped, objects can still be worked with. You may modify an individ-
ual object's properties (line color, fill color, text) once you select it in the

group:

It's not necessery to ungroup a group if you want to work with the objects
inside. You can use the Edit Group command under the Figure menu to open
a new window with all objects that belong to the group in it. Simply close the
window when done editing.

The Combine operation is a variety of grouping. The
difference is that combined objects take over the style
properties (line and fill color, line thickness and so on)
from the primary object (that with green handles),
whereas grouped objects retain their individual
properties.

ConceptDraw 45



Properties of objects

Each object has a number of changeable properties.

Line Properties

Lines are part of every object. To change their properties, use the LineProper-
ties dialog box (Format/Line), or the appropriate toolbar buttons for each
property (click "More..." under each button's menu to get to the LineProperties
dialog for a full list of options).

Line Properties

Line Arrow Styles

Style* [ 5; —————————— #)| Begn* [4: 44— ¢]
Width* | g —————— 4] End* | 12;————@ %]
Coor* [N || Sze* [ Smal 2|

—=| The Styles of Line Tool lets you choose among the
---------------- == | mostly used styles. For more styles, go to the
——-— = LineProperties dialog and choose any of the available 17

_ = = — line styles in the Styles drop down box.

There are line styles as follows: solid line (#1),
dashed line (#2), no line (#0), and their numerous
varieties.
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Use the Line Width tool to alter the line
width. The Width drop down box in the
LineProperties dialog offers the full list of §
sizes.

-
—
—

To set line color, use the Line Color tool, or
click on the Choose Color button in the Line
Properties dialog. The full palette includes
256 colors.

The Line Color tool offers you the first 16 colors of the palette. The Choose Color
button provides you with any color from the current palette. When you click this
button, a dialog window appears containing colors which you may choose from.
Click the mouse on the one you need. If you don't want to change the color, close

the dialog.

You may modify the color palette if you need other colors than it has (see the

Color Palette section).

You can apply an arrowhead to either or both ends of a line or any other
open figure. ConceptDraw offers 61 arrowhead styles for each line end to

choose from.
-
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You can use the Style Of Arrow tool to apply an
arrowhead to both line ends. The menu button gives you

the choice of 12 mostly used arrowheads.
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The Line Properties dialog allows you to specify arrowheads separately for the
beginning and the end of a line (in the Begin and End boxes respectively). The
size of the arrows can be chosen in the Size box. The following sizes are
available: Tiny, Small, Medium, Big, Large.

Fill patterns and colors.

For all closed figures, you may change their fill properties. They can be set in
the Fill&Shadow dialog box under the Format menu. Or you may change each
property by using the respective buttons on the toolbar. Clicking More ... under
each button menu opens the Fill&Shadow dialog, with the complete list of
available choices.

Fill & Shadow

— Fill

Fereground || ]|

Background * | I— |

38

Pattern: * | 7,

_ Shadow

Foreground | I |
Background * ||

Pattern: *

= To change the fill color of a selected figure, select the
&n Fill Color tool or click the Foreground butfon in the
Fill&Shadow dialog.
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Fill Color tool displays the fill color palette. On the palette, choose one of the
16 colors to fill the figure with that color, "More Fill Colors” to open the
Fill&Shadow dialog box where you can choose more colors or "No Fill Colors"
to make the figure transparent.

The "Foreground" button gives you the choice of picking any of 256 colors of
the current palette. Click the color you need. If you don't want to change color,
just close the dialog.

Use the "Fill Pattern” tool to fill figures with a

i pattern. It can also be done fiom the Fill&Shadow
dialog box under the Format menu. The "Fill Pattern”
tool lets you choose among the mostly used patterns.

The Background button under the Fill&Shadow dialog allows you to apply a
color to the pattern. The Pattern drop down box opens a list of 38 plain and 4
gradient patterns style.

| "

You may modify the color palette if you need other colors than it has (see the
Color Palette section).

Shadows
Use the Fill Shadow Style tool to apply shadows to objects and to choose the

shadow color. You can select one of the 16 colors from the palette to fill the
shadow with.
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Shadows, like fills, may be plain or have fill patterns. The complete lists of
colors and patterns may be found in the Fill&Shadow dialog box. In the
Pattern drop down box you can choose among 38 available pattern styles. The
"Shadow Foreground" and "Shadow Background" buttons determine the
foreground and background colors of the shadow respectively. For a plain
shadow, choose #1 pattern style in the Pattern box and its color in the
Foreground box. To remove the shadow, choose "None" (or #0 style) in the
Pattern box.

ConceptDraw allows you to specify the shadow offset. All shadows of a document
have the same shadow offset. Call the Document Properties dialog under the
File menu. Choose the Settings tab. In the "Figure Shadow Offset” section, type
values for the shadow offset in the Right and Down boxes (you may type
values in any measurement system, for example, 1 in, 35 mm). Then click OK.

Copying visual attributes of objects (Same Style).
@ Sometimes you may need to make all existing objects

appear in one style. This can be easily done using the
Make Same Style tool.

1). Select the objects you want to make same style.

2). Make the pattern object primary selection (click it once so that it show
green handles).

3). Click the Make Same Style button on the toolbar to make all selected
objects the same style as the pattern object.

When copying style, the following attributes of the primary object are
applied to the other objects:

1). Line color, thickness and pattern;

2). Fill color and pattern;

3). Shadow color and pattern;

4). Arrow pattern and size;

5). Text properties: font; font size, color and style; font background
color; margins and indentation.
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Protection

Various attributes of ConceptDraw objects can be locked against changes that
you do from the menus, or with the mouse or the keyboard. You can do this
in the Protection dialog by setting the corresponding options.

To lock some characteristics of one or more objects, select them and call the
Protection dialog under the Format menu.

Protection

_ Protect

—
0 g

[ Aspect Ratio *
] Begin Point
] End Paint

[ X Pesition

[ ¥ Pesition

[+ Rotation *

[J From Deletion

Here are the options:

® Width - locks/unlocks the object's width against resizing by using resize
handles.

® Height- locks/unlocks the object's height against resizing by using resize
handles. Locked handles will be displayed as grey padlocks, indicating
that you can't apply action to them.

® Aspect Ratio - locks or unlocks the ratio between the object's height
and width. When checked, the object will be resized proportionally by
dragging any of its resize handles.

® X-Position - locks/unlocks the horizontal (x) position of the object.

® Y-Position - locks/unlocks the vertical (y) position of the object.

® Rotate - locks/unlocks the object against rotation by dragging its rotation
handles. If the object is locked, its rotation centre can't be repositioned
either. Locked handles appear as grey padlocks indicating you can't
apply action to them.

® From Deletion - locks/unlocks the object so it or its handles can't be
deleted. If an attempt is made to delete a protected object, the warning
appears: "Object Is Protected From Deletion".
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Double click

The action that double clicking takes on an object is one of the properties of
the objects and can be modified. You can do it in the Double-Click dialog box
from the Format menu.

By checking one of the following options you set the action that will be performed

when the object is double-clicked:

® Perform No Action - takes no action.

o [Edit Figure's Text - opens the object's text box. You can edit a selected
object's text anyway by pressing the F2 key.

® Open Group In New Window - opens the Edit Group window. The same

can be done by choosing the Edit Group option from the Format

menu. This option works with groups only.

Open Figure's Table - opens the object's table.

Go To Hyperlink - double-click starts hyperlink processing.

OLE Verb - if it's an OLE object, double-clicking will start its editing in

the server application.

Perform User’s Context Menu Command - performs a command in the

user's context menu. If there are several items, each double-clicking

will perform the next command in the list.

Go To Page - on double-clicking the program goes to the drawing page

specified in the box.

Double Click

— When Shape is Doubdle-Click

i3 Perform No Action
® EdtText

i Open Groupin MNew Window
i3 Open Figure Tatle

i1 Open Hyperlink
i Perform User's Context Menu Command
(3 Go toPage: | Page-1 =]

The default option for groups is Open Group In New Window, for other
objects - Edit Figure Text.
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Information

The Information dialog allows you to edit additional information about the
object. It can be accessed from the Format menu.

Object Information

Sl 3

Marme: | ObID3 |
Deescription:

® In the Name field you may type the name you want to assign to the
object.

® In the Description field you may type information describing the object.
If such object is exported to HTML, these notes will display as hints in
the browser when pointing the object with the mouse.

o ID and SublID fields are used for reference only and can't be edited.

o 1D is the personal number of the object within the page, which is based
on the order in which objects are created.

® SubID - sequential number of the object within a group. It changes
when operations like SendToStepBack are performed.

The values in 1D and SubID fields are used when you
define one object through another using formulas. In
the table, they are used as references to parameters of
other objects. For more specific information, refer to
the Formulas section.
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Behaviour

You can describe the behaviour of selected objects in the Behaviour dialog. To
open it, on the Format menu click Behaviour.

Behaviour

— Interaction Style

{2 Line (1-Dimensicnal)
i Box (2-Cimensional)

— Selection Highlightng
[ Show Shape Handles
[ Show Comrol Handles
[ Show Alignment Box

__ Resize Behawicur

i) Scale With Group

i) Repasition Only
i Lise Group's Seting

InteractionStyle section determines whether the object is a connector or not.
Line (1-Dimensional). the object is connector. Besides, it behaves as a line when
you work with it. Box (2-Dimensional): the object is not connector.

Selection Highlighting section describes the way in which to display the object
when it's selected. The following options are available: Show Figure Handles,
Show Control Handles, Show Alignment Box. For instance, if you lock an object
against resizing, it's quite reasonable not to show its resize handles.

Resize Behaviour section determines how an object within a group behaves

when the group is resized:

® Scale With Group - always resize the object as the group's resized.

® Reposition Only - simply move the object without changing its size.

® Use Group's Settings - to use behaviour settings of the group to which
the object belongs.

The last option is set as default.
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Hyperlink

ConceptDraw allows you to link its objects to documents, pages of documents,
files or Internet locations, providing quick access to data of various kinds.

ConceptDraw has a remarkable ability for recognizing hyperlinks inside object's
text. When you type an Internet location or e-mail address, such text is treated as
ahyperlink.
You can follow a hyperlink using the menu (Format/
E HyperLink/Open), or by clicking the Open Hyperlink
button on the toolbar. If an object has no hyperlink,
the Hyperlink dialog will open where you can assign a
hyperlink to the object.

) Cti+Shift+H B Cmd-+Shift+H

The same dialog is used for modifying an existing hyperlink. It can be accessed
from the menu: Format/HyperLink/Edit.

il Ctrl+Shift+E B Cmd+Shift+E

Enable URL Autoparsing if you want the program to automatically recognize
and assign hyperlinks to Internet or e-mail addresses when you finish editing
an object’s text. This is an easy way of assigning hyperlinks to objects.
ConceptDraw will look for the following words in the text:

HyperLink

[+ URL aurtoparsing
Cancel I
{3 No HyperLink Local Browse... |

3 Bising CanceptDraw Document
() Other Program Or File

& Intermet

FILEAURL: [ wawawvconceptdraw.com

@ Page: | Page-1 o
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"http://" "news:"

‘hitps/ /)"
" ." "gopher://ll
"mailto:" "telnet:"
"ftp://" "Wa_is:"

All following text until a space will be regarded as hyperlink.

There are four types of links you may choose from:

- No Hyperlink: Disables the hyperlink. Note, that the text of the hyperlink is
kept intact so it can be easily reactivated if needed.

- Existing ConceptDraw document: Link to any existing ConceptDraw document.
You can either type in a path, or click Local Browse to navigate to the file. You
may use a relative path. It describes the path to the linked document starting
from the location in which the current document is stored. Clicking Open
Hyperlink opens the document you link to in a new window.

-Other program or file: Link to a file. You can either type in a path, or click
Local Browse to navigate to the file. You may use a relative path. It describes the
path to the linked file starting from the location in which the current document
is stored. Clicking Open Hyperlink starts the program used to process files of
such type.

-Internet; Link to an URL address. You can type in the address in the File/URL
field. If you click the Internet Browse button, an Internet search system launches
in your Internet browser. When you find the address you need, copy it, return to
ConceptDraw and paste it into the File/URL field. Then, when you click Open
Hyperlink, your Internet browser will start with the address saved.

-Page: Link to a page within the document. Select a page from the list in the Page box.
When you click Open Hyperlink, the chosen page will open in the same window.

= You can drag hyperlinks directly from your browser into
the File/URL field of the dialog. This will
automatically enable the Internet option.

By assigning hyperlink to an object you also redirect
its double-click action (you can learn more in the
"Double Click" section).

Hyperlink remains active even if the object is inside a
group. Thanks to this you can create tables and
complex objects with multiple hyperlinks.

ConceptDraw



Additional operations on objects
Insert Vertex

:Lpu% The Insert vertex tool adds an additional vertex to a
segment. Adding a vertex may be regarded as adding a

new segment to the already existing ones, or as
dividing a segment into two parts. To add a vertrex to
a segment, choose the Insert Vertex tool on the toolbar,
and click on the figure's outline between two exixting
vertices to add a new one. The new vertex appears,
creating a new segment.

If you perform this command when holding down the Ctrl or Cmd key, you
also cut the line in the place you insert the vertex. For a closed figure, this
operation will open it.

ENg RN g REEpENN

For an open figure, this operation will divide into two parts the geometry to which the
vertex was added.

Combine

In ConceptDraw, figures can consist of multi ple segments Several segments joined
together are called geometry. A figure may have more than one geometry.
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If you want to create a group of several objects, and all of the objects have the
same properties, such as fill color, line color, line thickness, etc., it's better to
use the Combine operation (Figure/Operations/Combine) rather than Group.
Combined objects take up less space when saved.

If overlapping figures are combined, the overlapping areas become transparent.

Join

The Join operation (Figure/Operations/Join) lets you make one figure from
several different ones. The main difference from the Combine operation is that
if a solid outline results after the operation, it's considered as a single geometry.
The Combine operation just groups figures with the same properties, but never
makes a new one out of them. That's why when a closed figure results after the
Join operation, it's filled automatically, which never happens when figures are
combined.
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Be sure to superpose the endpoints precisely (they
must have same coordinates). The Snap function is
very helpful for this purpose

Scattering

The Scattering operation is inverse to the Combine operation. If a figure consists of
several geometries, the Scattering operation will form an individual object for
each geometry of the object. It looks as if the object was divided into parts.

The Scattering operation takes no effect on objects
resulting afier the Join operation. The Join operation
make a single geometry of all the segments, so the
program can't recognize them as separate parts when you
perform Scattering. To split such objects into parts, select
the InsertVertex tool and holding down the Ctrl (Cmd)
key, indicate the points where you want to separate the
geometry, and then perform Scattering.

Connectors

A connector is used for linking two objects together. Its distinguishing characteristic
is that the connection is maintains even when the objects are moved, resized, etc.

l#r‘ B
bk

All connectors have a begin point and an end point (that is, they are 1D
objects). You glue these endpoints to connection points of other objects to
establish connection.
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You can always swap the begin and end points by
choosing Reverse Link from the context menu.

There are 2 methods for gluing a connector to an object:
Connecting to an entire object

Position one of the endpoints of the connector over the centre of the object's
alignment box, until a black rectangle appears round the object. On releasing the
mouse button, a magenta square will indicate the point at which the connector is
currently glued to the object. As you move the object, the point of connection will
jump to the side of the alignment box facing to the connector.

Gt Om

Connecting to a connection point of an
object

Position one of the endpoints of the connector over the object, until you see
a grey plus in a circle indicating the pointer is over a connection point of the
object. Release the mouse button to establish connection. The glued endpoint
turns red, indicating the place of connection.

1 O

To break connection, just move the connector or its attached endpoint away
from the objects.

Each object has 4 default connection points, in the middle of each side of its
alignment box. They become visible when you position an endpoint of a connector
over one of them and work the same as regular connection points.

There are 2 types of connectors: a smart connector and an object connector.
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Smart Connector

Smart Connector is composed of vertical and horizontal lines, which form a
solid path. The main feature of the Smart Connector is that the point of
connection changes its location when you move the object, keeping to the
side facing the connector.

—

#

T
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Control handles on the connector let you adjust its shape. The connector will
keep its shape until you move the connected objects.

og Use the Connector tool to create a Smart Connector. To get two
obyjects connected straight away, start and finish drawing the
connector over connection points of the objects.

Ctrl+9

Like other objects, a connector may have text in it. By default, the associated
text appears over its central control point, or where the lines meet. The text
may be then repositioned by using the Text Box tool.

—

Te Ii
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Object Connector. Direct Connector.

An object connector can be created from any 2D object into object connector
by simply transforming it into a 1D object. Select the object, call the Behaviour
dialog under the Format menu (Format/Behaviour) and enable the 1-Di-
mensional option.
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For a 1D object, dragging the endpoints resizes and rotates it at once. By
dragging the size handles, you control its height. If the rotate tool is on, the
endpoints are substituted with rotation handles.

Oy The most common variant of the object connector is the

= direct connector. You can draw it with the help of the
Direct Connector tool. To get two objects connected straight
away, start and finish drawing the connector over connection
points of the objects.

Connect Figures and Direct Connect tools

By g Use Connect Figures or Direct Connect tools to
connect an object to one or more other objects.

How fo use the tool: First select the object you want to connect to other objects
(it will display green handles). Then, with the Shift key held down, select the
objects to which the first object will be connected. Click the Connect Figures
or Direct Connect button. The object with primary selection will be connected
to the other selected objects.

] o
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Auto-connection modes.

"l

When in an auto-connection mode, all objects you draw or drop on the page
get automatically connected to previous selected objects with a connector. It
doesn't matter whether you draw the objects yourself, paste from another
application, take from a library, etc.

There are 2 connection modes: with the Smart Connector (Smart Connection
Mode) and with the Direct Connector (Direct Connection Mode).

Auto-connection mode is particularly handy for quickly sketching large schemes.
You don't need to think about connections, just arrange them on the page.

For example, switch to Smart Connection Mode. Draw or select the initial
element of the scheme. Then, as you add new objects, they'll be automatically
connected to the previous selected object.

Connection points

A connection point is a special kind of handle, to which connectors and control
points can be attached. They look like red or blue crosses. Selected objects
display their connection points in red, other objects - in blue. Note, that connection
points may lie both on the perimeter of the object and outside it. Then the red
color helps us undessand to which object the connection point belongs.

™ | To work with connection points use the Connection

Point tool.
Ctrl+0

REN

Selecting objects. When the Connection Point tool is on, you can select objects by
clicking an object with the Ctrl (Cmd) key held down. To copy a selected object, hold
down Ctrl (Cmd) and drag the object to where you want to place the copy.
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Creating connection points. The main purpose of the Connection Point tool is
to create new connection points. Select an object, and then click the object with
the Connection Point tool in the place where you want the new connection
point to be inserted.

Selecting, moving and deleting connection points. Connection points can be edited
(repositioned and deleted) with the Connection Point tool. To select a connection
point, move the mouse over it so that the pointer changes into «, and click
the mouse button. The selected connection point becomes bigger and turns red.

To move the connection point, drag it with the mouse to a new location. To
delete a connection point, select it and click the Del (Delete) key on the
keyboard.

Preventing connection points from displaying on screen. In ConceptDraw, you
may show and hide connection points. Under the View menu, uncheck the
Connection points item to hide the connection points, and check the item to
show them. Even when invisible, connection points remain operational.
Connection points inside a group.

You can work with connection points of objects which are part of a group.
Normally, these connection points are not visible. But when you select an
object in a group, its connection points appear in grey.

" E\”f
ﬁ /\ E\\//g
1 D_ b -
If you want to always see connection points in groups, enable Connection
Points In Groups on the View menu.

”"W/\
7\

Note, that connection points function even when they are not visible.

o m o
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Pictures

Picture is a type of object used in ConceptDraw.
Objects of this type allow limited editing only (rotating, resizing, etc.).

The following formats are supported:

raster formats: vector formats:
! Windows bitmap - bmp, Windows metafile - wmf,
. JPEG - jpg, enhanced metafile - emf,
: GIF - gif: MacOS picture - pict,
Encapsulated Post Script - eps.

Inserting a picture. To insert a picture into your document, select Picture
under the Insert menu. In the dialog box, click on the filename to select the file.
You can see a thumbnail of your image in the Preview in the box to the left.
Click the Open button to open the selected file.

The picture will be inserted in the centre of the active window. Note, that the
picture is now part of the document and is no longer related to the file it was
taken from.

ConceptDraw also allows to open image files in a separate document using the
Import command (for more information, refer to the "Importing Files" section).
Specifics of inserting vector images. When inserting images of a vector format
(wmf, emf, pict) you have an option to convert them in ConceptDraw objects.
This works differently in the Macintosh and Windows versions of the program:

In the document, select the picture you inserted and
= ) choose Ungroup from the Figure menu. The picture will
be converted into a ConceptDraw object(s)

When inserting a PICT image into the program, you Il be
ﬂ asked whether to convert it into ConceptDraw objects. If
you refise, the picture will be inserted in a raster format.
Ifthe document contains emf-objects, pasted there in the
Windows version of the program, such objects will look
like rectangles labelled "Windows Metafile” on a Mac.
However, same as on a PC, you can transform them into
ConceptDraw objects by performing Ungroup.

Creating images. ConceptDraw can also save objects as pictures. More information
about it can be found in the "Exporting Files" section.
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Working with text
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Most of ConceptDraw objects, except guide lines, pictures and OLE objects,
may contain text. If you select an object and start typing (or press F2), the text
editing mode will turn on.

If the text appears too small, it will zoom in automatically for better legibility.
Such behaviour is set by default. You can customize it in the Preferences
dialog (menu Edit/Preferences), Miscellaneous tab. Here you can set the minimal
font size in points from which auto zooming will activate, or disable auto

Zooming,

When done editing, press Esc or F2 to quit the text editing mode.

ﬂ With the Edit Text tool you can edit text in an
object. When this tool is active, the lower part of the
toolbar is replaced with a set of text editing tools you
can use to modify text properties. To start editing,
simply click the object with the mouse.

Te:-:t:l':[r durial [westerm) jlm j '
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Most of text editing operations involve wide usage of selected text blocks. Any
formatting or settings change affects selected blocks only. You can select text
blocks either with the mouse, or with Shift+<Arrow Key>.

The way text is positioned in relation to the object is

% determined by its text box. The Text Box tool allows you
10 resize, rotate and relocate the text, changing its appearance
and position independently of its object. When a new object
s created, its text boxs dimensions coincide with those of
the Alignment Box.

ConceptDraw



om0

o O-- 3 - ! :
OO0 - m - : i

oo

-2
o Tet o

on ﬁrﬁshing editing. To learn more about this feature and h'yperlinks refer to
the "Hyperlink" section.
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Adding text to a new object

Select an object and start typing text in it. Immediately, the text editing mode
turns on. When done editing, press the Esc key, or click outside the text box.
There are some other methods for switching to the
fext editing mode:
- double clicking an object.
- selecting an object and pressing F2.
- clicking an object with the mouse in the Edit Text mode.

Modifying text in an object

To switch to the text editing mode, select the Edit Text tool and click the object you
want. If you click on the text itself, the insertion point will be placed in the position
where you clicked. By clicking elsewhere on the object, the whole text gets selected.
If you start typing now with a text block selected, the text will be deleted. To
prevent this, click anywhere on the text or press an arrow key.
After you make made all the changes you wanted, press the Esc key, or click
outside the text box.

There are some other methods for switching to the

fext editing mode:

- double clicking an object.

- selecting an object and pressing F2.

Creatfing a "Text" object

A text object is an object which contains only text. To create a text object,
choose the Edit Text or Text Box tools from the toolbar. Use the mouse to draw
the text box on the page. On releasing the mouse button, the text editing mode
turns on. Type in the text. When you've finished typing, press the Esc key, or
click outside the text box.
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Changing text styles in selected blocks
The following operations can be applied to selected text blocks:

- Changing font. To change font, click the down arrow by the Font Name box and
then click the name of the font you want in the list.

Hp Arial [westemn] j IB j

M Ctrl+F

- Changing font size. To change the font size, click the down arrow by the Font
Size box, and then click the size you want in the list, or enter a custom size.

W You can quickly get to the drop-down list of font sizes
by pressing Ctrl+S.

You can also use the Increase Font Size and

A Decrease Font Size buttons on the Text toolbar to
— increase/decrease the font size gradually.
i 4l Ctl+> El Cmd+>
Ctrl+< Cmd+<

-Changing text color. Click the Text Color button on the toolbar. On the button
menu, click one of the given 16 colors, or click More Colors for extra colors. This
will bring up the Choose Color dialog box, where you can choose among 256
colors of the current palette of the document.

@'| Text Color Button

- Changing font attributes. Font attributes, such as Bold, Italic or Underlined
can be set by clicking respective buttons on the text toolbar, or by using
keyboard shortcuts: Ctrl(Cmd)+B for Bold, Ctrl(Cmd)+I for Italic,
Ctrl(Cmd)+U for Underlined.

B | Bold Text Bution 4] | Underlined Text
~ Bution

I | lulic Text Button
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Kl The Macintosh version of the program allows for
additional fext styles:
Outline (Cmd+0), Shadow (Cmd+S) u Condense
(Cmd+C).

Modifying text properties in selected objects.

You can change various text properties (such as font, font size, margins) for
several objects at once. To do this, call the Text Properties dialog (menu
Format/Text). Changes you make in this dialog will apply to all the selected
objects.

When in the Edit Text mode, some properties can be modified straight from
the text toolbar. For example, you can increase the font size or make the font
bold for all selected objects.

You can use Ctrl and Shift to select other objects.

Text alignment

Each text consists of one or more paragraphs. Each paragraph begins from a
new line and is separated from the others with line feed symbol (which is
inserted each time you press the Enter key). For each paragraph, you may set
alignment and indentation.

Horizontal alignment. Can be applied to paragraphs only. You can align text on
the left side of the Text Box, on its right side, or on its center. To align a
paragraph, click somewhere within its bounds and choose one of the alignment
tools on the toolbar: Left Align Text, Centre Align Text, or Right Align Text.
Several selected paragraphs can be aligned likewise.

Left Align Text Right Align Text
= Centre Align Text Ctrl+L
Ctrl+E
Cirl+R

‘g In the MacOS version of ConceptDraw, you can't see the
results of paragraph alignment when in the text editing
mode. The alignment will be applied after you leave the
text editing mode.
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Vertical alignment. Vertical alignment determines the position of the whole text
with respect to its Text Box. You can align the text at the top, middle or
bottom of the Text Box. Use the following toolbar buttons: Top Align Text,
Middle Align Text or Bottom Align Text.

E Top Align Text |£| Bottom Align Text

= Middie Align Text

Cuftting, copying and pasting text

When working with text, you may cut, copy and paste text blocks as you do in
many other Windows applications.

The Copy command copies selected text onto the clipboard. Choose Edit/Copy.

4l Ctrl+C K] Cmd+C
Ctrl+Ins

The Paste command pastes text from the clipboard into the pointer position.
Choose Edit/Paste.

4l Cirl+V Kl Cmd+V
Shift+Ins

The Cut command removes selected text from its place and puts it on the
clipboard. Choose Edit/Cut.

i Ctrl+X K] Cmd+X
Shift+Del

Working with Text Box

Text box is a dashed line with handles that selected objects display when the
Text Box tool is chosen. You can move, rotate and resize an object's text box,
thus modifying the position of the text in relation to the object.

When you move or resize an object, you move and resize its text box as well.

Moving a text box. To move the text box, first click on it to select it. Then click
its bounds or the text inside, hold down the mouse button and then drag. When
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text box is selected, the pointer changes into a double box indicating it can be
moved.
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You can use the Arrow Keys to move a selected text box by one pixel at each keystroke
for precise positioning. If more precision needed, increase the magnification.

Rotating a Text Box. To rotate a text box, drag any of the four rotation handles
located in its corners. The text box rotates around its rotation centre, which
looks like a grey circle.

Sizing a Text Box. To resize a text box, drag one of its square handles. The
mouse pointer will change into a double-headed arrow when it's over a

handle.
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Indents and margins

Margins. You can set margins for the whole text with respect to the Text Box
borders. Open the Text Properties dialog box (Format/Text), then select the Text
Block tab. Under the tab, modify the values in the Margins fields. Here you may
specify the values for the left, right, top and bottom margins. By default, you input
the values in the current measurement system. If you want to use another measure-
ment system, specify proper abbreviation for the chosen unit of measure after the
number. For example: 2, 4 pt, 3.3 in, and so on.
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Indents. Indents are paragraph properties. For each paragraph, you may set the
right, left and first line indents. These settings can be modified in the Indents
subsection of the Text Properties dialog (Format/Text, Paragraph tab).

By default, you input values in the current measurement system. If you want to use
another measurement system, specify the proper abbreviation for the chosen unit
of measure after the number. For example: 2, 4 pt, 3.3 in, and so on.

The changes will affect the paragraph with the insertion point, or those
containing selected text.

The resulting indent value includes the margin value
as well.

ﬂ In the MacOS version of ConceptDraw, you can't see
the results of paragraph alignment when in the text
editing mode. The alignment will take effect after
youve left the text editing mode.

Setting background color

By default, text has no background and text boxes are transparent (except for
text boxes of connectors). You may enable the background color for a selected
text block in the Text Properties dialog (Format/Text). Under the Text Block
tab, uncheck the Transparent option, and click the Text Background button to
choose a color. Click OK.

To disable the background color, check Transparent.
Text Properties dialog box
The Text Properties dialog has three tabs:

The Font tab. Here you may change the font properties.

o The Font box lets you choose a font from the list of available fonts.

® In the Size box, you may select a font size from the list or enter a
custom value.

® Color determines the font color.

e The Style section contains a group of options, that change the font
style attributes:
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Bold - determines whether the text is bold.

Italic - changes plain text to italic and vice versa.
Underlined - underlines the text.

Strikeout - displayes crossed out text.

Outline - outline only

Shadow - outline with shadow

Condensed - condensed

Extended - stretched out

Plain - no style

nﬂnﬂﬂnﬂnﬂﬁ

Text Format

Font [Geneva i] Size: _

Coor |

Styles
] Bad [ Mtalic [ Underline ] Qutine

[ Shadow [ Condensed [] Extended [ Plain

| Cancel | | oK, ||

The Paragraph tab. Specifies properties for the paragraph with the insertion
point, or for all paragraphs of a selected object.

® The Horizontal Alignment section specifies how the paragraphs are
aligned with respect to the text box: Left - on the left side, Centre - by
the centre, Right - on the right side.

® The Indent section specifies the paragraph indentation: FirstLine - for the
first line, FromLeft - for the left indent, FromRight - for the right indent.
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Note, that the indents values are displayed in the
currently used measurement system. If you want to
use another measurement system, specify the proper
abbreviation for the chosen unit of measure after the
number. For example: 2,4 pt, 3.3 in, and so on.

Text Format

— Horizontal Alignmert
i) Left & Centre i) Right

__ Indents

First Line: 0em

romert foom | MRS

Cancel | ok, II

The Text Block tab. Under this tab, you may set properties for the entire text box.

@ The Vertical Alignment sections determines the position of the whole
text with respect to the text box. Top - aligns text at the top of the text
box. Middle - aligns text at the middle of the text box. Bottom - aligns
text at the bottom of the text box.

® The Margins section specifies the distance between the text and the

edges of the text box. Left - sets the left margin. Right - sets the right
margin. Top - sets the top margin. Bottom - sets the bottom margin.
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Text Format

— Vertical Alignrmemnt

o Top & Mddle _» Botiom
— Margins
o =
e o
— Text Background
[ [ I] [f Transparent

l

Cancel

| 0K l|

Note, that the margins values are displayed in the
current measurement system. If you want to use
another measurement system, specify the proper
abbreviation for the chosen unit of measure after the
number. For example: 2,4 pt, 3.3 in, and so on.

o The Text Background section specifies the color for the text background.
Transparent - sets whether the text background has color or is transparent.

Color - sets the background color, if Transparent is unchecked.
Working with text in groups

Unlike other objects, a group doesn't have text associated with it. The text you type
in appears on the frontmost object in the group. If you want to change another
object's text, select the object and switch to the Edit Text tool (or press F2).

Note, that it's possible to change the display order of
objects using the SendTo... operations.
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Smart Connector's text.

By default, the Smart Connector's text appears on its central segment, if the number
of the segments is odd, or in the place where two middle segments meet, if the

number of the segments is even.

—

Teli
E]
|

Text ﬁ*J

Use the Text Box tool for repositioning the text.

Text AutoExpand Mode.

The Text Auto Expand mode serves for resizing an
object on the to fit text you re enteringwhen editing.

When this mode is on, the object's width and height are extended if the text
goes beyong the borders. Resizing only takes place when editing text.

Once activated, this mode works for all the open documents during the entire
work session. It's reset when you quit ConceptDraw

If the text box doesn't coincide with the object’s
alignment box, only the text box is resized. For I-D
objects, it's only the text box that is resized. The
actual object won't change its size

Undo and redo operations

76

Undo. When creating and editing objects, mistakes are inevitable. So, you may
need to cancel a sequence of recent actions and return the document to its
previous correct state. The Undo command can be used for this purpose.

toolbar or choose Undo from the Edit menu. The menu

- | To reverse the last action, click the Undo button on the
always shows the type of the action that will be undone.

i Ctrl+Z Bl Cmd+Z
Alt+BkSp
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The number of consecutive actions that can be undone is limited. The default
value is 30. You may specify your value under the Settings tab in the Document
Properties dialog (File/Document Properties). The higher the number, the
more memory the program requires to store the actions.

=

Redo. Redo operation is inverse to Undo. Use it to
reverse the latest Undo operation. Click the Redo
button on the toolbar, or select Redo under the Edit
menu.

il Ctri+Y K] Cmd+Y

Copying and pasting

You may exchange information between ConceptDraw and other applications
by using the Clipboard.The Clipboard is atemporary storage area, used by the
system to transfer data between documents and applications. By using the Cut,
Copy and Paste commands, you can copy onto the Clipboard selected text
(when the text editing mode is on), or selected objects (when the text editing

mode is off).

The Copy command creates a copy of selected objects
or text and places it onto the Clipboard. To perform
the command, click the Copy tool on the toolbar, or
select Copy fiom the Edit menu.

4l Cchl+C Kl Cmd+C
Ctrl+Ins

Once there is some dataon the Clipboard, it can be inserted into the same
document, or other documents and applications.

ConceptDraw
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Cut is a combination of two operations: Copy and
Delete. It places selected items on the Clipboard, and
then deletes them from the document. To perform the
command, choose Cut from the Edit menu, or click the
Cut button on the toolbar.

il Cirl+X Bl Cmd+X
Shift+Del
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On the Macintosh platform ConceptDraw uses the
PICT format to exchange data with other applications.

The Paste command inserts the contents of the Clipboard into the cursor

position.

Objects from other applications will be inserted as
OLE-objects.

®

To perform the command, select Paste under the Edit
menu, or choose the Paste tool on the toolbar.

il Ctrl+V Bl Cmd+V
Shift+Ins

If the system Clipboard contains a PICT image or
text the content of the Clipboard can be inserted into
a ConceptDraw document with the Paste From
Clipboard command.

If there's text on the Clipboard,the text will be
inserted into the object with primary selection (the
one displaying green handles). When none of the
objects is selected, a Text Box object will be created
and the text will be pasted into it.

Ifthere’s a PICT image on the Clipboard,you'll be
offered to either convert the image into ConceptDraw
objects, or insert as a picture.

If there's aConceptDraw object on the Clipboard, this command pastes the
content of the Clipboard into the same position on apage as that from where
the original object was copied or cut. It's particularly useful when you need to
copy or move an object onto another page of the document so that it's placed
in the same position of the page as the original object.

) Chi+shift+Vv B Cmd+Shift+V

i

For other applications’ objects this command works as
the "Paste” command.
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Chapter 3 Document
Working with a document

Zooming

Zooming is are helpful when editing a document. Use the Zoom In command to
magnify a portion of the page for more precise working. The Zoom Out command
may be needed for viewing a very large drawing, or to view the whole page.

Here's the row of preset zoom levels (in %):
1,2,3,6,13,25,50,75,100,125,150,200,400,800,1600,2500.

Zooming in or out sets a higher or lower preset zoom level respectivly.

5z =] & & .

@l Zoom In. Select ZoomlIn from the View menu, click
the button on the toolbar.

'i Ctrl+«+» ﬂ Cmd+<<[»
Cmd+«+»

Gl Zoom Out. Select ZoomOut from the View menu or
click the button on the toolbar.

il Cirl+«» Bl Cmd+«]»
Cmd+«-»
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Zoom Box. Allows to enlarge or reduce the view of a
potion of the page, covered by the zoom box.

To enlarge: Use the mouse to define a rectangular
area. On releasing the mouse button the enclosed
portion of the page will enlarge to the size of the
window.

To reduce: Hold down the Alt key, and define a
rectangular area with the mouse. On releasing the
mouse the view will reduce. The larger is the area,
the smaller results the view.

Sinlge clicking with the Zoom Box tool works like
ZoomIn command, or like ZoomOut if you hold down
the Alt key.

Zoom. This drop down box lets you choose the
magnification in percent from a list, or enter a custom
value within the 1-2500% range.

Grid

Each document page is crossed by thin grey lines, called grid lines.

You may enable/disable the grid from the View menu, by checking/unchecking
the corresponding menu item.

If the Snap To Grid option in the Snap&Glue dialog is enabled, the grid will pull
the pointer when you mani pulate objects. When you drag ahandle, the mouse
pointer will jump to the nearest grid node or cell centre. When moving an
object, the same occurs to its alignment box. This helps to position objects precisely.

You can assign the grid color for the entire application. This can be done in
the Options dialog box. Select Options from the Tools menu, then select the
Miscellaneous tab and set the color you want using the Grid Color button.

Also, you may set grid properties for each particular document. This can be done
in the Grid Properties dialog. Click Grid on the Tools menu to access this dialog.
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Usually, it's most convenient to use the Grid Spacing - Non-Fixed mode. In this
mode, the grid spacing remains visually the same regardless of the magnification,
which increases the accuracy with each zoom in level. For instance, if the spacing
is 0.5 cmat 100%, it will equal 0.25 cm at 200%. The cell size can be set separately
for the width and height. The following options are available: Fine, Normal, Coarse.

Grid Properties

— Grid Spzacing

Horizomtal Vertical
ofed [oon | [om || (o]
@ NonFixed | Normal ¢ | [Normal 4 |

__ Grid Origin

Horizontal Vertical
Grid Origin |0 cm | [oem

Another grid mode is the Fixed Grid mode. Then the grid spacing is a fixed
value, and changes visually with the magnification.

You set a specific distance the grid lines stay apart regardless of magnification,
though visually the distance changes.

You must use the Fixed mode if you want the grid to
be printed. Non-fixed grid can't be printed.

If you need to work constantly with a specifically
Jormatted grid, save these settings in a template file,
and create new documents firom this template.

Rulers

e ||I||'FI5|I|I||EEI|I|I|H'F|I

The rulers show measurements at the scale of the drawing. The current unit of
measure is displayed in the place where horizontal and vertical rulers meet.
You may change the unit of measure in the Document Properties dialog,
under the Settings tab.
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Another reason for using the rulers is that you can drag vertical and horizontal
guides out of them. To do this, click on the ruler and drag the guide out of it to the
place where you want it to appear. Release the mouse button. The guide will appear.

Note, that rulers can be enabled/disabled from the
View menu.

Guide lines

Guide line is a special ConceptDraw object, that may be used for aligning
objects and positioning them precisely.

Guide lines can be dragged out from the horizontal and vertical rulers. You
can manipulate (select, move, duplicate, delete, etc.) guides like other
objects.

In most cases, you'll use guides for gluing objects to them (see the Snap&Glue
section for specifics). So, by gluing objects to a guide you may then reposition
them at once keeping their relative distances.

It may be helpful when you're designing an office layout, or an electronic
scheme, where you first line up objects along a guide and then move the entire

group.

Normally, guides pull the pointer to them when snapping is on. This function-
ality may be disabled in the Snap&Glue dialog under the Tools menu (Tools/
Snap&Glue).

Guide lines aren’t printed.
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Scroll Hand Tool

Usually, you can only see a part of the drawing page on the screen. The Scroll
Hand tool is used for moving the page so that you can see its different parts. It
looks like a hand that grabs the page and moves it according to the mouse
movement. You can activate this tool in whatever mode by holding down the
Space key and dragging the page with the mouse.

| ﬁn-? Switch to the Scroll Hand tool, grab the page with the
mouse and move it in the direction you need.
Another option is to hold down the Space key when

dragging.

Snapping and gluing

Snapping is the ability of the mouse pointer to jump into position of the
nearest snap location. This feature is used for positioning objects precisely
with respect to the grid lines, rulers subdivisions, other objects, etc.

Use the Snap tool on the toolbar to turn the snapping

on/off.

_’i- You'll definitely welcome the possibility of turming Snap on/

O offon the fly. In any tool, you can invert the Snap mode by
holding down the Alt key. This helps to increase precision
of your drawing with ease.

You can specify snapping settings in the Snap&Glue dialog (Tools/Snap&Glue).

Snap and Glue

b4 Snap Cancel |
[ Ruler Sutxdmvisions

4 Grid oK

[] Shape Geometry

[ Guides

[] Shape Handles

[ Shape Vertexs

[ Connections Point

[ Glua
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If the Snap To Grid option is enabled, the grid will pull the pointer when you
mani pulate objects. When you drag ahandle, the mouse pointer will jump to
the nearest grid node or cell centre. When an entire object is moved, the same
occurs to its alignment box. By default, this option is set to on.

If Ruler Subdivisions is the only option that's enabled, the pointer will snap to
the imaginary lines, coming out of the rulers subdivisions. Use this for very
precise positioning.

If the Figure Geometry option is checked, the object you move or resize snaps
to the outlines of other objects. It's usually a good option when you need to
attach an object to another object.

If the Snap To Guide option is on, the pointer snaps to the guide lines. This
option is on by default.

Figure Handles: the pointer snaps to the nearest resize handle of an
object.

Figure Vertices: the pointer snaps to the nearest vertex of an object.

If the Connection Points option is on, the pointer snaps to the nearest connection
point of an object.

Even if snapping is enabled, the pointer jumps to a snap location when within
a certain distance to the location. This distance can be set in the Document
Properties dialog. The default value is 15 pixel. If you want to set a specific snap
sensitivity distance for all future documents, specify the new value in the
Preferences dialog, under the Default tab (Edit/Preferences...).

Gluing - is a property of objects to stay connected, even if one of the objects is
moved. Unlike snapping, gluing maintains the connection after you release the
mouse button. To ensure precise positioning of objects and handles, it's usually
a good idea to use gluing together with snapping.

|-t$' To enable/disable gluing , use the Glue On/Off

button on the toolbar or check the appropriate
option in the Snap& Glue dialog (Tools/
Snap& Glue).

You can glue objects to guide lines, control handles to guide lines, or control
handles to connection points of objects.
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Gluing objects to a guide line: Sometimes you may need to align objects along
a line, so that you can move all the objects at once by simply moving the line.
This is possible by gluing objects to a guide line. After you glue the objects,
they'll move together with the guide.

To glue an object to a guide: Turn the gluing mode on, then move the object to the
place on the guide you want to glue it to. After you release the mouse button, the
resize handles on the glued side of the object turn red indicating the object is glued
to the guide.

i . i

Gluing control handles to guide lines. Control handles can be glued to a guide. Tum
the gluing mode on, move the control handle to the guide line and release the
mouse button. Once glued, the control handle turns red. When you move the
guide line, all the glued control handles move with it.

Gluing control handles to connection points of objects. This is one of the main
reasons you may use the Glue tool for.

For instance, you have an object with a connector attached to it. Let's suppose
you need to group these to objects to mani pulate them together. However, in
this case the loose end of the connector will lose its ability of gluing to objects,
because it will be inside the group.

To solve this problem, you should add a control handle to the group, attaching
it to the loose end of the connector. Then you'll be able to glue the resulting
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new handle to connection points of other objects as if it were an endpoint of
the connector (to learn how to create one, look up the Working With The
Table chapter, Controls section).

To glue a control handle to a connection point of an object, turn gluing on and
move the control handle to a connection point of the object you want to glue it
to. On releasing the mouse button the control handle turns red, indicating that
it's connected to the object. Now, when you move the object, the connection

Scaling in documents

When you are drawing a layout that represents a large real-world object, you
may have to use scale (for instance, lcm=1m). Scale of the document can be
specified in the Document Properties dialog, under the Settings tab (File/
Document Properties).

In the dialog, you may choose one of the preset ISO scales: 1:1000, 1:500, 1:200,
1:100, 1:50, 1:25, 1:20, 1:10, 1:5, 1:2.5, 1:2, 2:1, 5:1, 10:1, 20:1, 50:1. If you need
a custom scale, choose the Custom Scale option and specify the desired proportion
in the appropriate fields, for example, 1=3, lin=1ft, lcm=1km, etc. For the list
of supported units of measure, please refer to the Measurements section.

The default scale is 1:1. If you need some other scale for all future documents,
save that scale configuration in a template file, and create all new documents
from this template.

Measurements

All numeric values used in the program are entered and displayed in certain
units of measure. The following units of measure are supported:
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For dimensions and distances:
inches, decimal
inches, fractional
feet, decimal
feet, decimal inches
feet, fractional inches
yards
miles
millimeters
centimeters
meters
kilometers

5 5

= =
N |
==

For angles:
degrees
radians

2§ ZB8s8g38

For font size:
points

=

You may specify units of measurement for a document in the Document Prop-
erties dialog, under the Settings tab. In the open document, the current units
of measure appear in the top left-hand corner, in the place where the horizontal
and vertical rulers meet.

If you're constantly working with the units of measure other than default,
enter them in the Units Of Measure field under the Default tab in the
Preferences dialog (Edit/Preferences). Then each new document will use this
units of measure.

In any input field of ConceptDraw dialogs, you may specify values in the
measurement systems other than default. Just put the appropriate abbreviation
after the number, for instance: 13 in, 2 mm, 6.5 ft.

Color Palette

When you choose a line or fill color from the button menus on the toolbar,
you may need other colors than those 16 the menus offer. Then click on "More
Colors" to bring up the Choose Color dialog, where you may pick any of the
256 colors of the color palette of the document.

Each document may have its own color palette. For instance, it's possible to
create a palette of 256 gradations of grey. However, you won't be able to use any
colors other than these.
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To modify the color palette of the document, open the Color Palette dialog
from the Tools menu (Tools/Color Palette).

Color Palette

Load Palette

=]
Save Palette

Cancel |

To change a color on the palette to another, click on the box with the color
you want to change and choose a new color from the standard dialog that will
come up. When all changes are made, you may save the resulting palette in a
.pal file. To do this, click the Save Palette button. In the file dialog choose the
folder where to store and type a filename for your palette. Then click OK. You
can use the saved palette in whatever document. Just load its file in the Color
Palette dialog.

Changing a color in the palette affects all objects in
the document using this color. The old color will be
replaced with a new one everywhere throughout the
document. This applies to fills, line colors, background
colors, text etc. Please be attentive when modifying the
color palette.
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Document Properties dialog (General, Page,
Seftings, Prinfing)

You can call the Document Properties dialog by selecting Document Properties
under the File menu (File/Document Properties).

The General tab. Here you may type information describing the document in
the fields as follows: Title, Subject, Author, Company, Description.

Document Properties...

__ Information

Tide: || ConceptDraw]
Subject: | |

Author: | |

canpar.| |

Descriptons:

Cancel ] | oK ||
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The Page tab. Specifies various settings for the entire page:

Document Properties...

— —

__ Qrientations

i Portrait i) Landscape

— Page Size

A4 210mm x 297 mm i]

) Standard
i Metric (1S0)
) Custom

Cancel I (0]4 “
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Orientation: specifies the page orientation. The Portrait option displays the page
taller than it is wide, and Landscape option swaps the width and the height
(the page is wider than it is tall).

Size: specifies the page dimensions. For Standard and Metric(ISO) options,
you choose one of the preset sizes from the respective list:

For Standard: Letter(8.5in*11in), Folio(8.5in*13in), Legal(8.5in*14in),
Tabloid(11in*17in).

For Metric(ISO): AS(148mm*210mm), A4(210mm*297mm), A3(297mm*420mm),
A2(420mm*594mm), Al1(594mm*841mm), AO(841mm*1189mm)

Custom option lets you enter custom values for the width and height of the
page. By default, all dimensions are displayed in the currently used measurement
system. However, you may enter values in any supported measurement system
(see the Measurements section).
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The Settings tab. Here you may specify various document settings.

Document Properties...

— Units of MeasLire — Undo and Snag
Undo Depth 100

[ inches, fractional i]

Snap Sensitive 15

_ Scale — Figure Shadow Offset

1:1 ¥
| 1
e 0 o

) Custom

Cancel I (0]4 “

Units of Measure: specifies the units of measure in which all numeric values
are displayed on the rulers, on the status bar, in the input fields of dialog
boxes, and in the table. For specifics, refer to the Measurements section.

Scale: Here you may choose one of the Standard (ISO) scales. If you need a

custom scale:

® Check Custom

® Two fields will appear, where you should specify the ratio of the
visual sizes on the page to the real sizes of the objects. For example,
1in = Ift; 1 cm = 2 km, etc... It's recommended that the units of
measure in the first field correspond to the current units of measure
of the document.

For more specific information, refer to the Scaling in documents section.
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Undo Dept: Specifies the number of consecutive actions that can be undone.
The default value is 30.

Snap Sensitivity: Sets the distance from which snapping and gluing activate.
This distance is set in pixels and doesn't depend on scale or magnification.

Figure Shadow Offset: Specifies the amount for horizontal and vertical shadow
offset for all objects in the document.

The Printing tab. This tab describes print properties of the document.

Document Properties...

— Paper Flacement Method Faper Orientations

@ Fortrait

® |L-+v o _— o Landscape

__Justification
) Left&Top of page

i Centre of page

i) Right&Bottom of page

Cancel I (0]4 “

922

Paper Placement Method:

If the document is larger than one printed page, this setting determines how the
document is tiled across sheets of paper: down, then over or over, then down. If
the document is smaller than one printed page, this setting is ignored.
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Justification:

If the document is smaller than a printed page, here you can control where the
document prints on a printed page - in the top left corner, in the center, or in
the bottom right corner. If the document is larger than one printed page, this
setting is ignored.

Paper Orientation:

This setting specifies the printed page orientation - either Portrait (a page
taller than it's wide) or Landscape (a page wider than it's tall). This setting is
saved together with the document, and if it's not the same as the page orientation
set for the printer, the program will use this setting rather than the printer's.

Changing the paper orientation doesn't change the
drawing page orientation and only affects the
orientation of the paper you print on.

Print Setup:
Calls the standard dialog where you can set the paper size, scale of the drawing, etc.

Printing documents

Arranging a document on pages

Concept Draw document might be bigger than one printed page. Because the
printed page and the document page are different things, the size of the printed
page is selected from the list of available sizes in the printer properties. The
document page size is selected in the document properties dialog box.

While printing a document, all pages of the document are printed out one after
another and split into printed pages if needed. For example, if the document
page is A3 size, the printed page size is A4, then each document page will be
broken up into 2 printed pages.

Some print settings, such as paper placement order, justification or paper
orientation are stored along with ConceptDraw documents. This settings can be
modified on the Printing tab of the Document Properties dialog.

If more than one sheet of paper is needed to print one page of the document,
you can set how the page is tiled across the sheets of paper: down, then over
or over, then down.
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If the document's page is smaller than one printed page, you can control how
it's positioned on the printed page: In the top left corner, in the center, or in
the bottom right corner.

Paper orientation is very important. For instance, if you want to create and
print a document of A4 size placed horizontally you'll have to do it in three
steps:

1). In the Document Properties dialog, the Page tab (File/Document Properties)
set A4 size and horizonral (Landscape) orientation. These settings only apply
to the pages of the document, they may be not the same as the correspondent
settings set for the printer.

2). In the Document Properties dialog, the Printing tab (File/Document
Properties) set the Landscape orientation for the printed page.

3). In the Print Setup dialog (File/Print Setup) select A4 size.

Printing
% | The Print command prints the document. To perform
the command, choose Print from the File menu, or

click the Print button on the toolbar.

il Ctrl+P Kl Cmd+P

Before printing starts, the Page Setup document will come up, where additional
printing properties can be set.

Print %]

— Printer
Froperties |

Harme: pzon EPL-5200

Statug: Default printer; Feady
Type: Epszon EPL-5200
Where:  WWSERGE“EpsonEFL

Comment: [ Pint to file
r— Print range Copies
Lo Mumber of copies: |'| 3:

£ Fages from: |1 b |1
) SElection @
ar. I Catcel
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Choose your printer type in the Printer section. If more than one printer is
available, you may choose the one you want from the list. Clicking the Properties
button will bring up the printer properties dialog box. It may vary for different
printer type. Normally, this dialog lets you set the printed page size, page
orientation, graphic printing properties, fonts and other.

In the same section, you may choose the Print To File option. Use this option
if you can't print the document at the moment. Then the program will store
information for printing in a file, which you'll be able to print on any other
computer connected to the printer identical to that specified in the file, even
if ConceptDraw is not installed on the system.

The Print Range section allows you to select pages to be printed if you don't
want the whole document to be printed out. Specify the start page and the end
page in the appropriate fields.

In the Copies section, set the number of copies of the document you want to
get printed and the print order.

When you are sure that all the settings are okay, click OK to start printing.

ﬂ For MacOS, dialog boxes for printing settings don't
have a common appearance and may vary with the
printer type. Besides the above settings, they may
contain some specific ones such as paper quality, paper

supply way, printing quality, etc.

Previewing the document
You may see how the printed document will look before you start printing it.

Choose Page Breaks under the View menu to see how the document will be
divided into printed pages. Bold grey lines indicate the corresponding non-printable
areas, thin - are the page separators.

@ The Print Preview command provides more functions.
Select Print Preview from the File menu, or click its
button on the toolbar. A new window will open where you

can see a few pages on the same screen at the same time.
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By ConceptDraw - [C5-Odesza Chart - Headquarters] [_ (O] x|
Frirt... I Hest Page

One Page I Zoom [n I ET I Cloze I

Fl

[Mouse; [1.750, 2125 R g

There are some buttons on the window toolbar:

o Print - starts printing the document.

o Next Page / Prev Page - let you view the document page by page
forward and backwards.

® One Page / Two Page - displays one or two pages on the screen.

® Zoom In / Zoom Out - changes magnification.

® C(lose - closes the Preview window.

Page setup

Select Page Setup from the File menu to access the Print Setup dialog box.
— Printer

Mame: Epson EPL-5200 Eroperties |

Status: Default printer; Feady
Tupe: Epgon EPL-5200
Whhere,  WWSERGESE pzonEFL

Cormment:

— Paper Origntation
Size: I.t’-‘n.4 210 % 297 mm j &% Portrait
Source: IUpper tray j ' | andscape

ak. I Cancel
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Choose your printer type in the Printer section. If more than one printer is
available, you may choose the one you want from the list. Clicking the Properties
button will bring up the printer properties dialog box. It may vary for different
printer types. In the Paper section enter the size of the printed page and the
paper supply way (depends on the printer type).

In the Orientation area- select the orientation of the pages in your printer
(Portrait - for vertical and Landscape - for horizontal orientation).

Working with document's pages

A Concept Draw document may consist of one or several pages. This is very
useful when there are descriptions, drawings and other various information in
one document.

A new document is created to have one page by default. However you can
create a template with several pages initially and create new documents using
this template.

A row of buttons in the bottom left-hand part of the screen corresponds to the
list of pages of the document. The current page is selected. To scroll through
the list use the buttons to the left.

)
ﬁﬂg Sales | Marketing | Develop... | Finance |

For operations on pages, you can use the Page menu or call the context menu
over the page bar at the bottom of the screen. The second way is more convenient.

Global properties of the pages

Orientation and size are global page properties. In ConceptDraw, these properties
are assigned to all the pages of the document in the Document Properties
dialog under the Page tab (File/Document Properties)

Size types. There are 3 types to choose from: Standard, Metric and Custom.
Each of them has a specific set of dimensions:

Standard: Letter - 8.5in * 11 in; Folio - 8.51in * 13 in; Legal - 8.5in * 14 in;
Tabloid - 11 in * 17 in;
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Metric(ISO): AS - 148 mm * 210 mm; A4 - 210 mm * 297 mm; A3 - 297 mm * 420
mm; A2 - 420 mm * 594 mm; Al - 594 mm * 841 mm; A0 - 841 mm * 1189 mm;
Custom: Sets the width and height of the page. You may enter the values in
whatever units of measure supported in Concept Draw, for example: 10 in, 2
ft, 30 cm...etc.

Orientation: Determines the way the page is displayed: Portrait - the height
and the width correspond to the specified values; Landscape - exchanges the
values for the height and the width. For example, an A4 size page will have the
297 mm * 210 mm dimensions, (i.e. will be wider than it's tall).

Document Properties...

— —

__ Qrientations

i Portrait i) Landscape

— Page Size

A4 210mm x 297 mm i]

) Standard
i Metric (1S0)
) Custom

Cancel I (0]4 “
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Printing pages

A document page and a printed page are not quite the same things. So, if the
document page is of A3 size, and the paper in your printer is of A4 size, each
document page will be printed out on 2 paper sheets. To see how the document
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pages will be arranged on printed pages, enable Page Breaks under the View
menu. Bold grey lines correspond to the non-printable areas of the page, thin
grey lines - are separators between the printed pages.

For example, if you want to create and print a document page of A4 size
horizontally rather than in its normally vertical orientation, then you have to
go through 3 steps.

1) In the Document Properties dialog (File/Document Properties), under
the Page tab specify A4 size and Landscape orientation. These are the document
pages parameters only, and they don't affect the printed pages parameters.

2) In the Document Properties dialog (File/Document Properties), under
the Printing tab specify Landscape paper orientation.

3) In the Print setup dialog (File/Print Setup), choose A4 size (and Landscape

orientation) as well. Check Page Breaks under the View menu to make sure
whether your settings are okay.

Adding a page

To add a new page to the document, choose Add from the Page menu. The
Page Properties dialog box will come up.

Page Properties

MName: |[Fage-1

( Cancel | oK ||

For every new page, the program suggests a name like "Page - N", where N is
the new page number. You may type in some other name, if you wish. Clicking
OK adds the new page to the page list, and you can edit it like all the other

pages.
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Deleting a page

To delete a page, choose Delete from the Page menu. The Delete Page dialog
will come up.

Delete Page

Pages:

Headguarters - Cancel
Sales
Marketing 0K
Development
Financa

i

1] 3
[t Update Pane Mames

In the list of pages select the page to be removed. If the Update Page Names option
is checked, the program will rearrange all pages with default names so that they have
correct numbers. On clicking OK the page you selected will be deleted.

Reordering pages

Reorder Pages
Fages:
Headguarters = Move Up I
Sales
Merkeong
Development
1] 3
[l Update Pane Mames
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Besides adding or deleting pages, you may sometimes want to change the
order in which pages are placed. To do this, choose Reorder from the Page
menu. The Reorder Page dialog box will come up.

Select a page from the list. Use the Move Up and Move Down buttons to
change its position in the list. If the Update Page Names option is checked, the
program will rearrange all pages with default names so that they have correct
numbers. Click OK to apply the changes.

Jumping to another page
There are 2 methods for jumping to another page.
First option is to click the respective page button from the list in the bottom

left-hand corner. To scroll the list, use the scroll buttons. Another option is to
specify the page in the Goto Page dialog (Page/Goto).

Goto Page =———=H

Select Page:

Headguarters = Cancel I
Sales

Marketing
Developoment

Finance

4] [»

Choose the page you want to jump to from the list and click OK.

You may set the double-click action of objects (see the
Double Click section), or their hyperlink options (see the
Hyperlink section) so that you use these objects as links
to other pages of the document.
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Naming a page

The name of the active page appears in main window title bar. To change it,
choose Properties from the Page menu.

Page Properties

MNamne: | Fage-1

[ Cancel | | oK ||

In the dialog, type a new name and click OK.

Working with layers

You can use layers to organize related objects in the document. For example,
when you're planning a house, you may assign all electrical system to one
layer, water-supply system to another, etc.

I Layer1 | = I ConceptDraw supports working with up to 9 layers, one
of which is active. To specify the active layer, choose

it in the box on the toolbar.

Each layer has a number of properties, which can be changed in the Layer
Properties dialog under the View menu (View/LayerProperties).

Layer Properties |
|_ayer Mame | Active | Wisible | Lock | Caolor |
Layer 1 hd v
Layer 2 il

L
["d ["d
'
["d ["d
'
["d
'

Cancel |
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e Layer Name - here you can change the default "Layer N" name to
a new one. Double click the name in the list, type a new one and
click OK..

® Active - only one layer at a time can be active. All new objects that are
drag or dropped on a page, belong to the active layer.

® YVisible - hides objects on the layer.

® Lock - locks all objects on the layer from being edited. You may find
this helpful for creating borders, background drawings, etc.

® Color - displays all objects on the layer in one color. To assign the
color, click the Color box and select a color from the Choose Color
menu. All objects on the layer will take on the chosen color. Uncheck
the option to return objects to their original color.

To modify a setting for all the layers at once, you may
click on the title bar of a section to select all the
layers.

Each object belongs to a layer. An object is assigned to a layer when you create
it or drop on the page. You can assign an object to another layer in the
SetLayer dialog under the Format menu. Select the new layer from the list and
click OK. You can also rename layers in this dialog.

Lavers
Layer 1 = | Rename I
Layer 2
Layer3
Layer 4
Layer 5 ok |
Layer 6
Layer 7
Layer 8
Layer 9 |
4| ID
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Chapter 4 Working with the
environment,
Templates.

104

A template is a ConceptDraw file which is used to store the desired set of
default settings for new documents (measurement system, grid spacing, scale
and other), list of libraries to open and a sample document.

i Template files have *.cdt extension.
e p

When you open a template, you open a copy of the sample document stored in
the template, and then all libraries according to the list. The document appears
in a new window, and the libraries are added to the already open libraries in the
library window.

There are several reasons for using templates.

»  When you need to create multi ple documents that have auniform look
(for instance, a weekly report form, or a product presentation template).
In this case, simply save the sample as a template once, and use this
template for creating new similar documents.

*  When your documents require specifically customized settings (related
to your country specifics, or the purpose you use ConceptDraw for).
This may involve page size, units of measure, font styles, text formatting,
grid properties and more. To eliminate the need of reconfiguring your
documents each time, make all settings once and save them in a template
file(s) for later use.

Notice, that settings for each new document are taken from the Blank
Drawing.cdt template, which is stored in the Libraries folder.
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»  When you have to create a document related to a specific field (for
instance, draw an office layout or a company structure), it’s usually a
good idea to use the task-related object libraries supplied with the
program. ConceptDraw includes ready-made templates with lists of
necessary libraries you may use for each specific task. These templates
are stored in the same folders as the appropriate libraries. You may
create similar templates for your custom purposes.

For more detailed information about opening templates please refer to the
Creating a new document from a template section.

For specifics about saving templates see the Creating a template file section.
Transporting templates.

‘When moving a template file from one computer to another, don’t forget that
a template file only stores references to its libraries rather than the actual
libraries. So, you must move the required libraries along with the template.
Make sure that the template and the libraries keep their relative positions with
respect to one another. Alternatively, you may place libraries in the same folder
as the template.

Workspace files

A workspace file stores information about sizes and arrangement of all the
windows open in the application and the list of open documents and libraries.

= | Workspace files have *.cdw extension.

By opening a workspace file, you reproduce the state in which the application was before
you saved the workspace file, with all documents and libraries keeping the same positions.

Here are some situations in which you may want to use workspace files.

»  When constantly working with the same set of documents and libraries.

»  When working with a document displayed in a specific way. For instance,
when you need to show tables for some objects, or when several magnified
areas of the same page are viewed in separate windows at once.

For more detailed information about opening workspace files please refer to
the Opening documents and libraries by using the workspace section.

For specifics about saving workspace files see the Saving a workspace file section.
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Transporting workspace files.

When moving a workspace file from one computer to another, don’t forget
that a workspace file only stores references to the documents and libraries. So,
you ought to move all necessary document and library files along with the
workspace. Make sure that the workspace file and the required components
keep their relative positions with respect to one another. Alternatively, you
may place the document and library files in the same folder as the workspace
file.

Program configuration

106

Global program configuration can be set in the Preferences dialog. To call the
dialog, select Preferences under the Edit menu.

The dialog contains the following sections: Default, File Paths, Internet,
Encoding, Miscellaneous.

Options...

@ Startusing a template

Template file

| :Libraries:Blank Crawing.cdt | [ Browse... ]
) Startusing the default setings

Default settings

Uniits of Measure: [ centimeters = ]

Snap Sensitivity (pixes):

Page Size: i3 Standard i Metric (150 i Custom

[A4: 210 mm x 297 mm ¢]

[J Showe the start dialog

Cancel I (0]4 “
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The Default tab describes the settings applied to each new document you create.
When creating a new document, ConceptDraw either takes the settings from a
template file or uses those set directly by the user.

The first way is default (Start using a template is selected). The Template field
specifies the template file on which a new document will be based (by default,
it's Blank Drawing.cdt stored in the Libraries folder). Use the Browse button to
select another template file.

If you select Start using the default settings, a new document will be set up
according to the configurations described below:

Units of measure:

Specifies the default units of measure. The rulers, the status bar, entry fields in
dialogs and the table will display values in this units of measure. For specifics,
refer to the Measurements section.

Size:

Specifies the default page size. You may choose one of the standard sizes by
checking Standard or Metric(ISO) and choosing a size from the drop-down list.
You may choose Custom to enter the dimensions manually. You may type in the
values in any units of measure supported by the program (see the Measurements
section).

Snap Sensitivity:
Sets the default distance within which snapping and gluing activate. This distance
is set in pixels and doesn’t depend on the scale or magnification.

The check box at the bottom of the dialog sets whether to show the Start dialog
when you launch the program.

The File Paths tab describes the default paths to ConceptDraw components; documents,
libraries, templates, help. To set a path use the Browse button or type it in the field.

‘When you call the File Open dialog for documents, templates or libraries first time
after the program started, the dialog displays the contents of the respective default
folder. Later, the File Open dialog displays the current folder for each file type.

The Internet tab specifies the path to the Internet browser which the program
uses to follow hyperlinks and search the Internet.
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Initially, this path corresponds to your default Internet browser. However, if
for some reasons this path is incorrect, you may specify the path to your
Web-browser manually.

The Encoding tab sets text encoding properties, which may be important when
you need to transfer your document from a Mac to a PC, or if you want to
read in a document created in the PC version, containing national language
symbols (say French, or Cyrillic).

By default, this setting is No Encoding, which means the documents will save
and open properly on your Mac, and will work fine on a PC in most cases.
However, if the text includes some national characters (like accented letters,
Ciyrillic or Greek letters), you'll need to set an encoding to ensure these characters
are readable on a PC.

You may set one of the following:

Western (Latin 1) - for Western European languages (French, German,
Scandinavian languages and other).

Central Europe (Latin 2) - for Central and Eastern European languages (Baltic
languages, Polish, Czech, and other).

Cyrillic - for Cyrillic-based languages (Russian, Ukrainian, Bolgarian, etc.)
Greek - for Greek

Turkish (Latin 5) - for Turkish.

If your document doesn't contain any non-English letters, leave No Encoding.

The Miscellaneous tab provides control over some additional settings of the
drawing environment.

The Enable Library Window Docking option toggles the docking
feature of the library window off or on.

The Enable Autoscrolling option sets whether autoscrolling is active. When it's
enabled, the page will be scrolled automatically when you move an object to
the edge of the page.

The Smart Selection check box allows to activate/deactivate the Smart Selection

mode, when a group of objects selected most recently restores its selection on
clicking any object within it.
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Text Edit AutoZoom. When this option is active, the program will automatically
zoom in on the an object when you start editing its text, if the text is tool small.
You can set the visible text size in points, under which autozooming activates.

The Grid Colorbutton allows to set a grid color for the entire application.

The Application Background Colorbutton assigns a color to the area of the
drawing window surrounding the page.
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Chapter 5 Libraries

ConceptDraw supports working with object libraries. Library is a file that contains
a collection of objects. These objects are usually organized in groups to represent
a particular topic, for instance: flow chart, computer network, engineering, etc.
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Library window

A special window, called the library window, is used to display open libraries.
It usually appears on the left side of the program window.

Buttons with names on the top of the library window represent currently open
libraries. The pressed button indicates the active library. Only one library at a
time may be active. The context menu for each library button contains the
following items:

New - creates a new library.

Open - opens an existing library.

Close - closes the active library.

Close All - closes all libraries.

Save - saves the active library.

Save As ... - saves the active library under a new name.

Properties - calls the Library Properties dialog.

View As Icon - displays only library object icons.

View As Text - displays only library object text.

Under the buttons list goes the contents of the active library. The objects can be
displayed in the form of icons, or in the form of text. When you position the pointer
over an object, its name appears in the status bar, if you pause the pointer over the
object, it also displays atip.The selected object shows ared border around its icon.

There are several ways of how the library window may appear:

o Alongside the document window. By default, it's positioned along the left
side, but may be placed along the right side, or (in the Windows version)
even along the bottom or the top of the drawing page. To dock the library
window to aside of the document, grip itstitle bar (for Mac), or the bar
that separates the library title buttons from the objects below (for PC), drag
it to the edge of the respective side, and let go of the mouse button. When
the library window is positioned this way, its width can be ajusted bydragging
the border adjoining the document window. The docking feature may be
enabled/disabled in the Preferences dialog, Miscellaneous tab..

o In floating state. This is the way in which windows usually appear. To
make the library window float, grip the bar that separates library title
buttons from the list of objects, drag it to the centre of the document
window and release the mouse button.

® In minimized state. You can reduce a floating library window to its title
bar, so that it takes minimum space and can easily restore its previous
size. To minimize the floating library window, uncheck Libraries from the
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View menu, or press F4. To bring the window back, check the menu item,
or press F4 again.

Library files allocation

All provided libraries are located in the Libraries folder of the program's root
directory. The Library folder contains task-related subfolders. Library files them-
selves (*.cdl files for Windows) are located inside these folders.

As you create your own libraries, you may store their files anywhere you want,
but we advise to create task-related subfolders inside the Library folder and
place your library files there, to keep them in good order.

Opening a library

To open one or more libraries, choose Open Library from the File menu. The
File Open dialog will come up.

All the libraries supplied with ConceptDraw are located in task-related folders.
Select the folder (volume) you want in the upper box and then one or more
library files in the main box, and click OK. The library window will open, including
all chosen libraries.

[n]| You can use the Open Library tool on the Standard toolbar.

il Both libraries and document can be opened by dragging
their file icons from Explorer or My Computer
windows, and dropping them onto the program window.
In this case you have to drag the file icon, position it
over the respective taskbar butfon, wait until the
application window opens, and then release the mouse
button over the toolbar or over the library window.

As you release the button, the mouse pointer must look

like this:
4]
ﬂ Both libraries and documents can be opened by

dragging their file icons over the application icon.

If you open a library that's already listed in the library window, by opening it
again you'll make it active, not duplicate it.
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Creating a new library

You can create your custom object library, using the New Library command
from the File menu. The File Open dialog will open. Choose a folder where you
want the library file to be stored, and in the name field specify the filename for
the new library file. Click OK. The empty library window will open. Now you can
add these objects from documents or other libraries.

Closing a library

To close a library, open its context menu and select Close Library menu item.
If any changes were made after the library was last saved, the program suggests
that you save changes before closing the library.

To close all open libraries, choose Close All from the context menu.

Saving a library

To save a library, open its context menu and choose Save from the menu.

If you need to save the library under another name, choose Save As. The Save
dialog will come up, where you may specify the name for the library and
choose where you want it to be stored.

Library properties

To set or modify properties of a library, call its context menu and choose
Properties from the menu. This will bring up the Library Properties dialog box.

=——————library Properties

Title: I Charting Figures

Autor: | Vaslly Badera

|

Subject: |BusinessDiagram | H oK ]I
|
|

Company: | Computer Systems Odessa corp.

Description:

Title: the name of the library you see on its title button. Subject: a topic to
which the library can be related. Author: the author's name. Company: the company
name.Description: ashort description.

To save changes, click OK in the dialog and then save the library.
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Displaying library objects as icon and as
text.

There are two ways of viewing library objects: as icons or as text. To switch
between the options, call the context menu for the library window and choose
one of the following items: View As Icon or View As Text.

View As Icon. A library object icon has the size of 29*29 pixel. When you insert
an object into a library, the program creates its icon automatically. However,
you may substitute it with a custom icon. Do the following: *).Create a 29*29
pixel image in Windows Bitmap (.bmp) format, which you want to assign as
the icon. You can use any graphic editor, MS Paint for one. *).Call the context
menu for the object, which icon you want to change. From the menu, select
Change Icon. In the File Open dialog, find the file with the icon, select it and
click OK.

View As Text. In this mode, library objects look like small boxes with text
inscriptions at their side.One of them can be selected.

Properties of library objects

To assign and change a library object’s properties, use the Library Item Properties
dialog. To bring up the dialog, open the context menu of the library object you
want and choose Item Properties from the menu.

Library item properties

[tern namme: Fie chart

ltern prompat | Represents a customizable pie chart. |

=

o Item Name - the text of the tip which appears when you pause the
pointer over the object.

e Item Prompt - text which appears in the status bar when you position
the pointer over the object.
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Inserting a library object info your
document

There are several methods for inserting a library object into your document:

By dragging and dropping. Point to a library object, hold down the left mouse button
and drag the object from the library window to the document page. Release the
mouse button where you want a copy of the object to be inserted.

By double-clicking the object. If you double-click an object in the library window, its
copy will be inserted in the centre of the active page of the document.

By using Copy & Paste.

Open the context menu for the object, and select Copy from the menu. A copy
of the object will be placed on the Clipboard. Then, in the document window,
call the context menu again and choose Paste from the menu. The contents of
the Clipboard will be inserted in the position of the pointer.

By using the Stamp tool.
In the Stamp mode, by clicking somewhere in the document you insert there a copy
of the selected library object. See the Stamp Tool section of this Help for details.

If a connector tool is on and there is a selected object
in the document, the object you paste will be
automatically connected to the selected object. The
object you ve just pasted becomes selected. So you can
connect objects according fo the order in which you
insert them in the document.

Adding an object from the document to
a library

There are several ways of adding a new object to a library:

By dragging and dropping. Point to an object, in the document hold down the
mouse button and drag the object from the document window to the library
window. Release the mouse button where you want a copy of the object to be
inserted.
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Optionally you may use Ctrl+X(Cmd+X) for cutting the object from the
document.

Using Copy & Paste. Open the context menu for the object in the document,
and select Copy from the menu. The copy of the object will be placed on the
Clipboard. Then in the library window, call the context menu for an object in
the library, and perform Paste from the menu. This will shift the object there,
inserting the object on the Clipboard in that place.The inserted object becomes
selected. To add an object to the end of the library, call the context menu on an
empty place in the library window and paste the object there.

Inserting a selected object. A selected object can be added to a library in an
alternative way. From the Edit menu, perform Put Into Library command. This
will place the selected object in the library, shifting the selected object there. If
there was no object selected in the library, the object from the document will
be added to the end of the library.

As an object is inserted in the library, the program creates its library icon
automatically. For how to change the library objet icon, see the Displaying
library objects as icon and as text section.

Copying objects between and within
libraries

After you get acquainted with the libraries provided with ConceptDraw, you
may want to create a compilation of the library objects you used most frequently.
You can do this by using the Copy/Paste operations for the library objects.

Switch to the source library, select an object (it shows red border) and open its
context menu. Select Copy from the menu. Then switch to the target library (or
create a new library), choose a place where you want the object to be inserted, call
the context menu there and select Paste from the menu to insert the object.

Another method is dragging library objects with the mouse. To insert a copy of
an object into some other library, drag it with the mouse, move over the target
library title bar, wait until the library opens and release the mouse where you
want the object to be inserted.

To reposition an object within a library simply drag it to the new location. If you

hold down the Ctrl (Cmd) key while dragging, a copy of the object will be
inserted.
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Delefing an object from a library

To delete an object from a library, open the context menu for the object and choose
Remove from the menu. After you confirm deleting, the object will be deleted.
Another option is to use the Cut operation. This one first copies the object on
the Clipboard, and then deletes it, so you may use the copy to insert it into
some other place in the document, or in another library.

Replacing an object under the existing
library icon.

When editing your libraries, you may need to update a library object without
changing its icon. To do so, use the Replace Library Object command under

the Edit menu.
il Ctrl+Shift+i K] Cmd+Shift+i

Select the object in the library, then the updated object in the document and perform
the command. You'll get a confirmation message when the operation is over.

Stamp Tool

ﬂ Stamp Tool lets use a library as a set of drawing
tools.

Ifthere's a library object selected, and the Stamp mode is on, clicking once in
the document will insert there a copy of the object (stamp it).

You may resize the object at the same time as you cteate it. Just drag the mouse
to draw a rectangular area of the desired size, and release the mouse button. In
fact, you copy the library object and resize it at the same time. For proportional
resizing, hold down the Shift key.

Stamp Tool is the most convenient way to quickly link objects using library
connectors. If there's a 1D object (connector) selected in the library, you can
attach it to objects straight away, as you do with regular connectors. To invert
the direction of the connector, hold down the Shift key.

When in the Stamp mode, regular operations, such as selecting, repositioning,
resizing are also available.

If there’s no object selected in the library, this tool will
clone the selected object(s) in the document. If several
objects are selected, their copies will be automatically
grouped, allowing immediate resizing.
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Chapter 6 Working with the table

Each ConceptDraw object is determined by dozens of parameters, such as
numbers, text or formulas.

All the parameters are brought together in the table, where each of them
can be modified. To call the table of an object, select it and choose Show
Table from the Figure menu, or press the F3 key. This will open the object's
table in a new window.
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Input field

The input field is at the top of the window. When you select a cell in the table, its
contents appears in the input field where it can be edited. Double clicking a cell
selects its data that appear in the input field. To finish editing, press the Enter
key. To return to the initial values press the Esc key (you may also click the
respective icons to the left of the input field).

Cells

A cell is the place where the program stores a parameter of an object. Once a
cell is active, you may edit its contents in the input field at the top of the table
window. To quickly start editing, double click the cell. You may use the arrow
keys to change the active cell.

What you see in the cell depends on the viewing mode set for the table. These
modes are the Values mode and the Formulas mode. When in the Values
mode, all cells show the values in the current units of measure of the document.
When the Formulas mode is on, all cells that have formulas in them display
the formulas. The cells which have no formulas, show the values in the tenths
of millimetre. Note, that if a cell show the formula, the input field will always
contain a formula when you select the cell, regardless of the viewing mode.

Not every cell allows to input a formula in it. Some support only numeric values.
The cells that allow formulas display their contents in blue, the rest display the

values in green.
FillPattern 1 5
I FilForegnd =_|F[Parent.\fanag 5
| IS =T i c
You can input values in units of measure other than default. For instance: 12
in, 3.5 ft, 0.66 m.

When editing the contents of a cell, you may use the data of another cell, by

clicking that cell with the mouse:

o Single click - adds its formula to the input field.

® Click with the Ctrl (Cmd) down - adds the numeric value to the input
field.

® Click with Alt down - adds the name of the cell (to refer to it in
formulas).
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By using formulas, you can make one parameter of an object dependent upon
other parameters, or upon the actions of the user. Here are some examples of
formulas:

® Variables. X1+(Variables.X2-Variables.X1)*0.293
o min(0;Geometryl.X2-Variables.X2)
o = [F(Variables.X1=1;_Setf("Variables. X1";0); Setf(""Variables.X1";1))

If you want to address a contents of a cell, in a formula indicate the name of the
cell (it appears in red near the cell). For instance: Width, TextAngle, etc.

For sections, where you can add cells (sections as Geometry, Controls, Connect,
Variables, Font Format, Paragraph Format, Actions), other addressing is used:
<section name>.<cell name>

The section name is composed of the column name and the string number.
For example: "Controls.YDyn1"; "Variables.Y2"; "Connect. X1"

For the Geometry section, the section name also includes the section number -
because a figure may have more than one geometry. For example: Geometryl.Y1,
Geometry2.C2. So, for the first two cells the names look like this:
"Geometryl.Visible" and "Geometry1.Filled"

Formulas often include functions. The full list of functions and their specifics
can be found in the Functions section.

Another case is when you want to address cells that describe other objects.
Every object has its identification number (you may see it in the title bar of the
table window, or in the Information dialog, ID section). This ID is used when
addressing the parameters of an object: "ObjID13.Geometry2.X1" or
"ObjID2.Width".

If the object belong to a group, you should use the Parent prefix to address
parameters of the group. For instance: "Parent. Height"

If you address objects within a group, it looks like this: "Child2.Angle". The

number after the name corresponds to the order of the object within the
group. You may see this number in the Information dialog (SublD field).
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The program may create some formulas automatically. Such formulas are called
default formulas. For instance, when we create a line, the program will describe

one of its parts as follows:

Froperties TRUE FALSE

1.5kart width=0. 000000 | Height0. EEEEET
2LineTo Wwidth"0, 70000 | Height*0. 000000
3LineTo WAdth=0. 70000 | Height*1. 000000
4 LineTo “wiidth=1. 000000 | Height*0. EEEEET

Here, Width*0.75000 and Height*0.666667 are default formulas. Due to the
formulas, vertices keep their positions with respect to the alignment box of the
object when the object is resized. This formulas change when you reposition
vertices of the object.

If a formula has the "=" sign near it, it means that the user can't alter the
formula, unless they edits its cell. If the formula hasn't the "="sign before it, it
may be altered when you apply actions to the parameter it represents.

Sections

The table window has a number of sections. Each section describes a functionality
of the object (for instance, its position, dimensions, text, etc.). For every
section, you may hide it or make visible. To show/hide sections, use the View
Sections dialog (select Sections under the View menu).

Some sections may be missing, if the object doesn't have the corresponding
item (for instance, control handles or the context menu). To add sections, use
the Insert Sections dialog (Insert Section under the Edit menu).

Here is the list of sections the table may have:
1. Transform

2 Geometry

3. Endpoints

4. Controls

5. Connect

6. Variables

7. Line Properties
8 Fill Format

9. Protection

0. Text Transform
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11. Character Format
12. Paragraph Format
13. Text Block Format
14. Text Field

15. Miscellaneous

16. Actions

One of the sections is active (its title bar appears in blue). You may edit cells in
the active section. To make a section active, click its title bar or any of the cells
inside it.

Each section can be minimized so that only its title bar appears. To minimize
a section, activate it and then click the title bar. Click again to expand the section.

For some sections (such as Geometry, Controls, Connect, Variables, Font For-
mat, Paragraph Format, Actions), a row of cells may describe a single element of
the object (such as a control handle, a linear segment of a figure, and so on). In
this case, operations on the whole row are possible: Add Row, Delete Row.

Transform section

This section contains parameters which define the position, size and orienta-
tion of the object. Note, that the coordinate system is based on the alignment
box of the object: the coordinate origin is in the top left-hand corner, horizontal
coordinates increase as you move from left to right, and vertical coordinates
increase as you move from top to bottom.

(0: 0 Width

Height
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Since an object may be part of a parent group, the following parameters describe its
position within the group (relatively to the coordinate system of the group):

OriginX, OriginY, Angle, LocPinX, LocPinY for a 2D object
BeginX, BeginY, EndX, EndY, Angle, LocPinX, LocPinY fora 1D object.

Note, that if an object isn't part of any parent group,
the program considers that it belongs to the group
Jormed by the entire page.

OriginX

Origin'

Y

Here are the fields of the section:

Width. Describes the width of the alignment box of the object. In the Formulas
mode, you see the data in tenths of millimetres, in the Values mode all data is
displayed in the current unit of measure. As a rule, the Width parameter is used
as a variable in formulas for other fields.

1D objects usually have the formula in this field:  HYP(EndX-BeginX;EndY-BeginY).
If the object is part of a group, its width is described through the width and
height of the parent group.

For example: HYP(Parent. Width*0.308575; Parent. Height*0.283963).

Height. Describes the height of the alignment box of the object. In the Formulas
mode, you see the data in tenths of millimetres, in the Values mode the data is
displayed in the current unit of measure. As a rule, the Height parameter is
used as a variable in formulas for other fields.
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Usually there is a number in this field. If the object is part of a group, its height
is described through the width and height of the parent group. For example:
_ HYP(Parent.Width*0.267234; Parent. Height*0.081973).

Angle. The angle of the object with respect to its parent group. Describes the
width of the alignment box of the object. In the Formulas mode, you see the
angle in radians, in the Values mode the angle is displayed in degrees. The
angle value may range from -180 deg to 180 deg.

1D objects usually have the formula for the angle:

FlipX* PI()+ ATAN2(EndY-BeginY;EndX-BeginX).

OriginX. Specifies the X offset of the rotation centre of the object with respect
to its parent group. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of
measure.

OriginY. Specifies the Y offset of the rotation centre of the object with respect
to its parent group. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of
measure.

LocPinX. Describes the X offset of the rotation centre of the object in relation
to the coordinate origin of the object. In the Formulas mode, you see the data
in tenths of millimetres, in the Values mode the data is displayed in the current
unit of measure. The default formula is Width*0.5

LocPinY. Describes the Y offset of the rotation centre of the object in relation
to the origin of the object. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of
measure. The default formula is Height*0.5

FlipX. The flag for horizontal fli pping.This is abinary value: FALSE - the
object isn't flipped; TRUE - the object is flipped;

FlipY. The flag for vertical flipping.This is abinary value: FALSE - the object
is flipped; TRUE - the object isn't fli pped.

Geometry section

This section describes geometries (or solid paths of segments) of the object.
Since an object may have more then one geometry, there may be several
Geometry sections. Then a number follows the section name:
Geometryl,Geometry2,...
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To add a new Geometry section: Open the context menu in the table window
and select Insert Sections from the menu. The Insert Section dialog will come
up. In the dialog, choose the Geometry option and click OK. A new Geometry
section will be added to the table. It will have three rows: Properties, Start and
LineTo.

Sometimes it is possible that Geometry sections exist in the table but you can't
see them because they are hidden. To make Geometry sections visible:

- Call the context menu in the table window, and select View Sections from the menu.
- The View Sections dialog will come up. In the dialog, check the Geometry
option and click OK.

A segment may represent a point, a part of a line, an arc of a circle or of an
ellipse, apart of the spline. In the table, the end of one segment usually
coincides with the beginning of the adjoining segment.

All coordinates appear in the coordination system of the object.
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Geometryl

Properties TRUE FaLSE

1.5kart Width*0.000000 | Height*0. 389588

2 LineTa Width*0.250000 | Height=0.084332

AT Width*0LE25000 | Height®0.289588 | Width*0.577563 | Height*0.083663

4 ElipzeTao Width*0.750000 [ Height*0.847397 | “Width*0.500000 | Height*0.694794 | _ELLIPS
5.5plineStart Width*0. 750000 | Height*0.847397 | “Width*0.880208 | Height*0.694794
£.5plinek.not Width*1.000000 | Height*1.000000 | *fidth*0 963542 | Height*0.730171
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You can add a segment to the active section. Call the context menu and choose
AddRow from the menu. A new LineTo segment will be added to the Geometry
section.

Properties.X This parameter defines whether the sequence of segments is visible
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or not. The value appears in the binary format: TRUE - the sequence of
segments is visible; FALSE - the sequence of segments isn't visible.

The default value is TRUE.
By changing this flag, you may hide or display geometries of an object.

In formulas, this parameter is addressed in the following way:
GeometryN.Visible, where N - is the number of the geometry.

Properties.Y This parameter defines whether the fill of the object is visible. It
works only for closed geometries. The value is binary: TRUE - show fill;
FALSE - hide fill;

The default value is TRUE.

In formulas, this parameter is addressed in the following way:
GeometryN.Filled, where N is the number of the geometry.

Start. The starting point of the file of segments. X and Y fields contain the
respective coordinates. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of
measure.

Each Geometry section has only one Start parameter.

LineTo. A linear segment. The X and Y fields contain the respective coordinates
for the end of the segment. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of
measure. The coordinates for the begin point of the segment are taken from the
X and Y fields of the previous segment.

ArcTo. An arc of a circle. This segment is defined by three points. The coordinates
for the begin point are taken from the X and Y fields of the previous segment,
positions for the end point are stored in the X and Y fields, and for the point
on the arc - in the A and B fields. In the Formulas mode, you see the data in
tenths of millimetres, in the Values mode the data is displayed in the current
unit of measure.

EllipseTo. An arc of a circle. This segment is defined by three points, and two
additional parameters. There are: the ratio of the large semi-axis to the small
semi-axis and the large semi-axis angle. The coordinates for the begin point
are taken from the X and Y fields of the previous segment, positions for the
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end point are stored in the X and Y fields, and for the point on the arc - in
the A and B fields. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of
measure. The C field contains the the ratio of the large semi-axis to the small
semi-axis. If this value equals 1, an ellipse arc becomes acircle arc.The D
field is large semi-axis angle with respect to the frame of reference of the
object. In the Formulas mode, you see the angle in radians, in the Values
mode the angle is displayed in degrees. The angle is usually within 0 to 180
degree range.

SplineStart. The starting segment of the spline. It is defined by two points: the
begin point (X and Y fields) and the guide point (A and B fields). In the
Formulas mode, you see the data in tenths of millimetres, in the Values mode
the data is displayed in the current unit of measure.

The SplineStart segment in the table should be followed by one or more Spline-
Knot segments.

SplineKnot. Is a segment of the spline. It is defined by four points: the begin
point (X and Y fields of the previous segment), the begin guide point (A and B
fields of the previous segment), the end point of the segment (X and Y fields)
and the end guide point (A and B fields).

In the Formulas mode, you see the data in tenths of millimetres, in the Values
mode the data is displayed in the current unit of measure.

Endpoints section
This section describes the coordinates (X and Y) of the begin and the end
points of the 1D object with respect to the parent group.

BeginX. Describes the X offset of the begin point with respect to the origin
point of the parent group. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of
measure.

BeginY. Describes the Y offset of the begin point with respect to the origin
point of the parent group. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of
measure.

EndX. Describes the X offset of the end point with respect to the origin point
of the parent group. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of
measure.
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EndY. Describes the Y offset of the end point with respect to the origin point of
the parent group. In the Formulas mode, you see the data in tenths of millimetres,
in the Values mode the data is displayed in the current unit of measure.

Conftrols section
This section describes control points of the object. Since an object may have no
control points, this section may be missing in the table.

To add this section to the table:

- Open the context menu in the table window and select Insert Sections from the menu.
- This will bring up the Insert Sections dialog box. From the dialog, check the
Control Points box and click OK. The Controls section will be added to the
table. It will have one row (that is, one control point).

Sometimes it may be possible that the Controls section already exists in the
table, but is not visible.

To make the Controls section visible:

- Open the context menu in the table window, and select View Sections from the menu.
- The View Sections dialog will come up. From the dialog, check the Control
Points box and click OK. The Controls section appears in the table.

To add a control point: Open the context menu for the section you want, and
select Add Row from the menu. A new row describing a control point will be
added to the end of the section.

To delete a control point: Open the context menu for the row you want to delete,
and select Delete Row from the menu. The row describing that control point will
be removed. Removing the last control point removes the section with it.

All parameters in the Controls section refer to the coordination system of the object.

X. Describes the X offset of the control point. If you didn't change this value, the
origin point for the offset is determined by the value in the X Behaviour field: 0,
1,2, 5,6, 7 - offset with respect to the left side of the alignment box (for
instance, Width*0.25); 3,8 - offset with respect to the centre of the alignment box
(for instance, Width/2-63.5); 4,9 - offset with respect to the right side of the
alignment box (for instance, Width-190.5).

In the Formulas mode, you see the data in tenths of millimetres, in the Values
mode the data is displayed in the current unit of measure.
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Y. Describes the Y offset of the control point. if you didn't change this value, the
origin point for the offset is determined by the value in the Y Behaviour field: 0,
1,2,5,6,7 - offset with respect to the top of the alignment box (for instance,
Height*0.75); 3,8 - offset with respect to the centre of the alignment box (for
instance, Height/2+63.5); 4,9 - offset with respect to the bottom of the alignment
box (for instance, Height-63.5).

In the Formulas mode, you see the data in tenths of millimetres, in the Values
mode the data is displayed in the current unit of measure.

XDyn. This is the X coordinate of the end of the line that drags behind the control
handle as you move it. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of measure.

YDyn. This is the Y coordinate of the end of the line that drags behind the control
handle as you move it. In the Formulas mode, you see the data in tenths of
millimetres, in the Values mode the data is displayed in the current unit of measure.

XBehaviour. This parameter determines how the control point moves along the
X axis when the object is resized. If there was a default formula in the X field,
the program changes it according to the XBehaviour field value after the
control point is repositioned.

When resizing the object:

0 The control point repositions proportionally with respect to the alignment
box.

1 The control point repositions proportionally with respect to the alignment

box. Repositioning with the mouse along the X axis is locked.

The distance stays constant to the left side of the alignment box.

The distance stays constant to the centre of the alignment box.

The distance stays constant to the right side of the alignment box.

The control point is invisible. When resizing the object, the control

point moves proportionally with respect to the alignment box.

The control point is invisible. When resizing the object, the control

point moves proportionally with respect to the alignment box.

Repositioning with the mouse along the X axis is locked.

7 The control point is invisible. When resizing the object, the distance
stays constant to the left side of the alignment box.

8 The control point is invisible. When resizing the object, the distance
stays constant to the centre of the alignment box.

9 The control point is invisible. When resizing the object, the distance
stays constant to the right side of the alignment box.
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YBehaviour. This parameter determines how the control point moves along the
Y axis when the object is resized. If there was a default formula in the Y field,
the program changes it according to the YBehaviour field value after the
control point is repositioned.

When resizing the object:

0 The control point repositions proportionally with respect to the alignment
box.

1 The control point repositions proportionally with respect to the alignment

box. Repositioning with the mouse along the Y axis is locked.

The distance stays constant to the top of the alignment box.

The distance stays constant to the centre of the alignment box.

The distance stays constant to the bottom of the alignment box.

The control point is invisible. When resizing the object, the control

point moves proportionally with respect to the alignment box.

6 The control point is invisible. When resizing the object, the control
point moves proportionally with respect to the alignment box.
Repositioning with the mouse along the Y axis is locked.

7 The control point is invisible. When resizing the object, the distance
stays constant to the top of the alignment box.

8 The control point is invisible. When resizing the object, the distance
stays constant to the centre of the alignment box.

9 The control point is invisible. When resizing the object, the distance
stays constant to the bottom of the alignment box.

[ SN US I \S)

Comment. Use this field to assign a tip to the control point. If this field is not
empty, the text in the field will show up when you pause the mouse pointer
over the control point.

Connect section
This section describes the connection points of the object. Since an object may
have no connection points, this section may be missing in the table.

To add this section to the table: Open the context menu in the table window and
select Insert Sections from the menu. This will bring up the Insert Sections
dialog box. From the dialog, check the Connection Points box and click OK. The
Connect section will be added to the table. Initially, it will have one row (that
is, one connection point).

Sometimes it may be possible that the Connect section already exists in the
table, but is not visible. To make the Connect section visible: Open the context
menu in the table window, and select View Sections from the menu. The View
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Sections dialog will come up. From the dialog, check the Connection Points
box and click OK. The Connect section appears in the table.

To add a connection point: Open the context menu for the section you want,
and select Add Row from the menu. A new row describing a connection point
will be added to the end of the section.

To delete a connection point: Open the context menu for the row you want to
delete, and select Delete Row from the menu. The row describing that connection
point will be removed.

Removing the last connection point removes the section with it.

All parameters in the Controls section refer to the coordination system of the

object.

X. This field describes the X offset of the connection point. In the Formulas
mode, you see the data in tenths of millimetres, in the Values mode the data is
displayed in the current unit of measure.

Y. This field describes the Y offset of the connection point. In the Formulas
mode, you see the data in tenths of millimetres, in the Values mode the data is
displayed in the current unit of measure.

Variables section
This section describes additional variables of the object. Since an object may
have no additional variables, this section may be missing in the table.

You may need variables when several different fields use results of the same
calculations. So, the additional variables can be used to store the results. You
may also use the additional variables to store various object parameters, which
you're working with, so that you don't have to refer to them.

To add this section to the table: Open the context menu in the table window and
select Insert Sections from the menu. This will bring up the Insert Sections
dialog box. From the dialog, check the Variables box and click OK. The Variables
section will be added to the table. It will have one row.

Sometimes it may be possible that the Variables section already exists in the
table, but is not visible. To make the Variables section visible: Open the context
menu in the table window, and select View Sections from the menu. The View
Sections dialog will come up. From the dialog, check the Variables box and click
OK. The Variables section appears in the table.

To add new variables: Open the context menu for the section you want, and
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select Add Row from the menu. A new row for variables will be added to the
end of the section.

To delete a row with variables: Open the context menu for the row you want to
delete, and select Delete Row from the menu. This will delete the row. Removing
the last row removes the entire section with it.

Each row contains two variables: X and Y. In the Formulas mode, you see the
data in tenths of millimetres, in the Values mode the data is displayed in the
current units of measure.

Line Properties section
This section contains variables which describe the appearance of the lines that
form the object. Others define the shape and size of the arrowheads, which
geometries may have on their ends.

LineStyle. This parameter sets the dash or dot pattern for the line. One of the
following values can be used: 0 - the line is invisible; 1 - the line is solid; 2 -
16 - different dash or dot patterns.

LineWidth. Describes the line width. One unit equals one tenth of millimetre.
The valid value range is 1 to 500 units.

LineColor.
Specifies the line color. The value in the field corresponds to the color number
in the color palette if the document. The value range is 0 to 255.

BeginArrow. This parameter specifies the type of arrowhead for the beginning
of each geometry of the object. You may use one of the following values: 0 - no
arrowhead; 1 - 60 - different arrowhead types.

EndArrow. This parameter specifies the type of arrowhead for the end of each
geometry of the object. You may use one of the following values: 0 - no arrowhead,;
1 - 60 - different arrowhead types.

ArrowSize. Specifies the size of the arrows on the object. The following sizes are
available:

Tiny;

Small;

Medium;

Big,

Large.

AW = O
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Alternatively, you may change these settings in the
Line Properties dialog box.

Fill Format section

In this section you may set parameters describing the fill and shadow proper-
ties.

FillPattern. Sets the fill pattern. The following values are available: 0 - no fill
pattern; 1 - fill with plain foreground color (FillForegnd); 2 - 38 - use a fill
pattern; 50 - 53 - use gradient fill pattern.

FillForegnd. Sets the foreground color. The value in the field corresponds to the
number of the color in the color palette of the document. The valid values are
010 255.

FillBackgnd. Sets the background color. The value in the field corresponds to
the number of the color in the color palette of the document. The valid values
are 0 to 255.

ShadowPattern. Sets the shadow fill pattern. The following values are available:
0 - no fill pattern; 1 - fill with plain foreground color (ShadowForegnd); 2 - 38
- use a shadow pattern;

ShadowForegnd. Sets the shadow foreground color. The value in the field corre-
sponds to the number of the color in the color palette of the document. The
valid values are 0 to 255.

ShadowBackgnd. Sets the shadow background color. The value in the field corre-
sponds to the number of the color in the color palette of the document. The
valid values are 0 to 255.

Alternatively, these settings can be changed in the
Fill& Shadow dialog box.
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Protection section

It this section you may lock some parameters of the object against changing
them with the mouse. However, even when locked, this parameters can be
still changed in the table, or may be changed when you apply some actions
to a group to which the object belong (like resizing - when resizing a group
with an object locked against resizing within it, it will be resizes with the
entire group, in spite of the protection). The locked handles appear as grey
padlocks.

All values of this section are binary values.

LockWidth. Locks the object's width against sizing. TRUE - the width can't be
sized; FALSE - the width can be sized.

LockHeight. Locks the object's height against sizing. TRUE - the height can't be
sized; FALSE - the height can be sized.

LockMoveX. Locks the object against moving it horizontally. TRUE - horizontal
movements are prohibited; FALSE - horizontal movements are allowed.

LockMoveY. Locks the object against moving it vertically. TRUE - vertical move-
ments are prohibited; FALSE - vertical movements are allowed.

LockAspect. Locks the object against unproportional resizing. TRUE - only pro-
portional resizing is possible; FALSE - both proportional and unproportional re-
sizing is possible.

LockCalcWH. Sets whether the alignment box of the object remains the same
after you move a vertex on the object, or changes according to the new object
outline. TRUE - the alignment box remains the same; FALSE - the alignment
box changes according to the new outline.

LockRotate. Locks the object against rotation. TRUE - the rotation is prohibited;
FALSE - the rotation is allowed.

LockDelete. Lock the object so it cannot be deleted. When you're trying to delete a
locked object, it displays a warning that it can't be deleted. TRUE - the object is
protected against being deleted; FALSE - the object can be deleted.

If you want to protect a large number of objects against being deleted, it's
convenient to assign them all to a specific layer, and then lock that layer in the
Layer Properties dialog.
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LockBegin. Locks the begin point of the object (for 1D objects) against
repositioning: TRUE - the point is locked; FALSE - the point is not locked.

LockEnd. Locks the end point of the object (for 1D objects) against repositioning
TRUE - the point is locked; FALSE - the point is not locked.

LockVertex.Prevents vertices from being edited with the mouse. TRUE - the
protection is on; FALSE - the protection is off.

Note: Alternatively, some of these parameters can be
changed in the Protection dialog box.

Text Transform section

This sections contains parameters which define the position, size and orientation
of the text box of the object. The values are represented in the coordinate system
of the object, which is based on the alignment box of the object: the coordinate
origin is in the top left-hand corner, horizontal coordinates increase as you
move from left to right, and vertical coordinates increase as you move from
top to bottom.

TextWidth. Describes the width of the text box. In the Formulas mode, you see
the values in tenths of millimetres, in the Values mode all values are displayed
in the current unit of measure.

By default, the text box width is the same as the alignment box width.

TextHeight. Describes the height of the text box. In the Formulas mode, you
see the values in tenths of millimetres, in the Values mode all values are
displayed in the current unit of measure.

By default, the text box height is the same as the alignment box height.

TextAngle. The angle of the text box with respect to the alignment box of the
object. In the Formulas mode, you see the angle in radians, in the Values mode
the angle is displayed in degrees. The angle value may range from -180 deg to
180 deg.

The default value is 0 (the text box isn't rotated).

TextOriginX. Specifies the X offset of the rotation centre of the text box in the
coordinate system of the object. In the Formulas mode, you see the values in
tenths of millimetres, in the Values mode all values are displayed in the current
unit of measure.
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TextOriginY. Specifies the Y offset of the rotation centre of the text box in the
coordinate system of the object. In the Formulas mode, you see the values in
tenths of millimetres, in the Values mode all values are displayed in the current
unit of measure.

TextPinX. Specifies the X offset of the rotation centre of the text box in the
coordinate system of the text box. In the Formulas mode, you see the values in
tenths of millimetres, in the Values mode all values are displayed in the current
unit of measure.

The default formula is: TextWidth*0.5.

TextPinY. Specifies the Y offset of the rotation centre of the text box in the
coordinate system of the text box. In the Formulas mode, you see the values in
tenths of millimetres, in the Values mode all values are displayed in the current
unit of measure.

The default formula is: TextHeight*0.5.

Character Format section

The text of any object is composed of one or more text blocks. A text block is
a section of text with the same formatting styles, that is, same font, font size,
font color and font attributes (bold, italic, etc). In the Character Format section,
each block is described in an individual row. The title field of each row shows
the position of the last character of this block counting from the beginning of
the entire object text.

Font. This field contains the number of the font it has in the font list of the
document. The program generates this list based on the fonts installed on your
system. If you paste in the document some text with the font that's missing on
your system, the program will display this text in the Arial font.

Size. This field contains the font size in pixels. Only positive values can be used.

Color. This field specifies the color of the text in the block. The value corresponds
to the number of the color in the color palette of the document. The value
may vary from 0 to 255.

Style. The number in the field describes the font attributes for the text
block. Each attribute is associated with a digit in the binary representation
of the number: 2°0=1 - bold; 2*1=2 - italic; 2"2=4 - underlined; 2"3=8 -
crossed out.
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So, the number for the bold italicized font will be 1+2=3.

Note: alternatively, these parameters can be changed
under the Font tab of the Text Properties dialog.

Paragraph section

A paragraph is a text block, that ends with the line feed symbol. An object's text can
consist of one or more paragraphs. Paragraphs may have alignment and indentation.
The amount of indentation doesn't depend on the scale of the document.
Normally, the paragraph section contains several rows, each of them describing
one paragraph. The title field of each row shows the position of the last
character of the paragraph counting from the beginning of the entire object
text.

FirstInd. Specifies indentation for the first line of the paragraph. In the Formulas
mode, you see the data in tenths of millimetres, in the Values mode the data is
displayed in the current unit of measure. This value doesn't depend on the
scale of the document.

LeftInd. Specifies indentation for the left side of the paragraph. In the Formulas
mode, you see the data in tenths of millimetres, in the Values mode the data is
displayed in the current unit of measure. This value doesn't depend on the scale
of the document.

RightInd. Specifies indentation for the right side of the paragraph. In the Formulas
mode, you see the data in tenths of millimetres, in the Values mode the data is
displayed in the current unit of measure. This value doesn't depend on the
scale of the document.

HAlign. This field describes the horizontal alignment of the paragraph in relation
to the text box. The number in the field corresponds to the following allignment
type: 0 - align on the left side of the text box; 1 - align on the centre of the text
box; 2 - align on the right side of the text box.

Note: Alternatively, these parameters can be changed
under the Paragraph tab of the Text Properties
dialog.
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Text Block Format section
This section describes global text properties of the object. They are the alignment,
margins and background color.

VAlign. Specifies the vertical alignment type of the text in relation to the text
box of the object. The number in the field corresponds to the following alignment
type: 0 - align on the top of the text box; 1 - align on the center of the text
box; 2 - align on the bottom of the text box.

TopMargin. Specifies the distance between the text and the top of the text box.
In the Formulas mode, you see the data in tenths of millimetres, in the Values
mode the data is displayed in the current unit of measure. This value doesn't
depend on the scale of the document.

BottomMargin. Specifies the distance between the text and the bottom of the
text box. In the Formulas mode, you see the data in tenths of millimetres, in the
Values mode the data is displayed in the current unit of measure. This value
doesn't depend on the scale of the document.

LeftMargin. Specifies the distance between the text and the left side of the text
box. In the Formulas mode, you see the data in tenths of millimetres, in the
Values mode the data is displayed in the current unit of measure. This value
doesn't depend on the scale of the document.

Note, that the actual distance between the text and the
left side of the text box also includes the paragraph
indentation (LeftInd field in the Paragraph Format
section). For the first line of the paragraph, add the
FirstInd field as well.

RightMargin. Specifies the distance between the text and the right side of the
text box. In the Formulas mode, you see the data in tenths of millimetres, in the
Values mode the data is displayed in the current unit of measure. This value
doesn't depend on the scale of the document.

Note, that the actual distance between the text and the
right side of the text box also includes the paragraph
indentation (RightInd field in the Paragraph Format
section).

TextBkgnd. Describes the text background color. The value corresponds to the
number of the color in the color palette of the document. The value may vary
from 0 to 255.
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Note: Alternatively, these parameters can be changed
under the Text Block tab of the Text Properties

dialog.

Text Field section

This section has only one cell, named The Text, which contains the text,
associated with the object. The text must be in quotation marks.

Some hints on how you can use this section:

- Suppose that the text of an object contains some information you want to
use as a parameter for other objects. It may be the height of a column in a
diagram, so that the column changes its height according to the value you
type in it.

So, as you type in a new value, the text gets into the TheText cell in the table.
Then in another cell, say, Variables. X1, this text is transformed into a number
(=_evaltext(TheText)), which you can use for further calculations.

- The text can also reflect this or that object or system parameter. For instance,
you may assign an object to show the system time, its angle, its width, or
similar, as the text. Then the TheText cell addresses that parameter.

For example: in the Variables. X5 cell the sector size as a percentage is stored.
To show this value in the text of the object, specify the following in the
TheText cell: = valtotext(Variables. X5)+"%".

Miscellaneous section

This section contains parameters that define the appearance and behaviour of
the object.

ObjHandles. A binary value, which defines whether the object's rotation and
resize handles are visible or not. TRUE - the handles are visible; FALSE - the
handles are invisible.

AlignBox. A binary value, which defines whether the object's alignment box is

visible or not. TRUE - the alignment box is visible; FALSE - the alignment box is
invisible.
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NonPrinting. A binary value, which defines whether the object will be printed
when you print the page. TRUE - the object will not be printed; FALSE - the
object will be printed.

ResizeBehavior. This field determines the way the object behaves when you
resize the group to which it belongs. 0 - Corresponds to the group's appropriate
setting; 1 - Simply repositions keeping the size; 2 - Resizes when the group
is resized.

CtriHandles. A binary value, which defines whether the object's control handles
are visible or not. TRUE - the control handles are visible; FALSE - the control
handles are invisible.

ShowText. A binary value, which defines whether the object's text is visible or
not. TRUE - the text is visible; FALSE - the text is invisible.

Actions section
In this section, you may create and describe the user's context menu. Since an object
may have no user's context menu, this section may be missing in the table.

To add this section to the table: Open the context menu in the table window and
select Insert Sections from the menu. This will bring up the Insert Sections dialog
box. From the dialog, check the Actions box and click OK. The Actions section will be
added to the table. Initially, it has one row (that is, one menu item).

Sometimes it may be possible that the Actions section already exists in the
table, but is not visible. To make the Actions section visible: Open the context
menu in the table window, and select View Sections from the menu. The View
Sections dialog will come up. From the dialog, check the Actions box and click
OK. The Actions section appears in the table.

Each row in the section corresponds to a user's menu item. To add a new menu
item: Open the context menu for the section you want, and select Add Row. A
new row will be added to the end of the section.

To delete a menu item: Open the context menu for the row you want to delete,
and select Delete Row. This will delete the row that describes this user's menu
item. Removing the last row removes the entire section with it.

Action. This field determines the action the program takes when the menu item is
clicked. For instance, clicking the menu item can assign a value to a parameter of
the object: SETF("Variables.X4";0.2). To create the line, that separates one menu
item from another (separator), input in this field any number other than 0.
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Menu. Type the name of the menu item here. The name must be enclosed in
brackets.

Prompt. The text that will appear on the status bar when you position the
pointer over the menu item. The text must be in quotation marks.

Checked. The flag that defines whether the check mark to the left of the menu
item should be displayed. TRUE - show the check sign; FALSE - don't show
the check sign.

Disabled. The flag that disables the menu item (when disabled, the item is

dimmed and can't be selected). TRUE - disable the menu item; FALSE - enable
the menu item.
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_ABS

_ABS(arg) Returns the absolute val-
ue of the arg number.

_ABS(str)

Returns the str string without
changing it.

Examples:

_ABS(-3)=3

_ABS(0)= 0

_ABS(4)=4

_ABS("Text") ="Text"

_ACOS

_ACOS(arg)

Returns the arc cosine of the arg (its
value is within the -pi/2 to pi/2 range).
The argument value must be within
the -1 to 1 ranger. Otherwise the er-
ror code generates.

_AND

_AND(argl;arg2)

Returns the bitwise AND;
_AND(strl;str2)

Returns 1 - if the strings are not
empty, and 0 - if at least one of
them is empty.

/ Functions

_AND(str;arg)
_AND(arg;str)

Returns arg.

Examples:

_AND(1;0)=0
_AND(3;2)=2
_AND("Hello!"; ™) =0
_AND("Textl"; "Text2") =1
_AND("Text"; 2) =2

_ANG360

_ANG360(arg)

Returns the arg angle, reduced to
the 0 to 2*pi interval.

Examples:

_ANG360( 481 deg) =121 deg
_ANG360( -4.5 rad) = 1.7832 rad

_ASIN

_ASIN(arg)

Returns the arc sine of arg (its
value is within the -pi/2 to pi/2
range).

The argument value must be within
a -1 to I range. Otherwise an error
code is generated.
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_ATAN

_ATAN(arg)

Returns the arctangent of arg (the
returned value is within the -pi/2 to

pi/2 range).

_ATAN2

_ATAN2(argl;arg2)

Returns the arctangent of (argl/
arg2). Unlike the ATAN function,
_ATAN?2 correctly processes expres-
sions where the arg?2 value equals 0.
Anyway, the returned value is with-
in the -pi/2 to pi/2 range.
Examples:

_ATAN(1;0) =190 deg
_ATAN(2;2)=45deg

_AUTHORNAME
_AUTHORNAME()

Returns the document author's
name, which you specify in the
Document Properties dialog (File/
Document Properties).

Example:

"Author: "+ AUTHORNAME()=
"Author: Bill Jonson"

_CENTERX

_CENTERX()

Returns the X coordinate of the
centre of the object. The centre of
the object is:

- for the smart connector - the mid-
dle of its central segment, if the
number of segments is odd, or the
crossing point of two middle seg-
ments, if the number of the seg-
ment is even.

- for the rest objects - the centre of

the alignment box.
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This function may be used, say, for
positioning the smart connector's text.

_CENTERY

_CENTERY()

Returns the Y coordinate of the
centre of the object. The centre of
the object is:

- for the smart connector - the mid-
dle of its central segment, if the
number of segments is odd, or the
crossing point of two middle seg-
ments, if the number of the seg-
ment is even.

- for all other objects - the centre
of the alignment box.

This function may be used, say, for
positioning the smart connector's
text.

_CIRCLE_CENTERX
_CIRCLE_CENTERX(X1;Y1; X2;
Y2; X3;Y3)

Returns the X coordinate of the
centre of the circle, built upon the
three points: (X1;Y1), (X2;Y2) and
X3Y3).

_CIRCLE_CENTERY
_CIRCLE_CENTERY(X1; Y1; X2;
Y2; X3;Y3)

Returns the Y coordinate of the
centre of the circle, built upon the
three points: (X1;Y1), (X2;Y2) and
X3Y3).

_CIRCLES3RD_X
_CIRCLES3RD_X(XI;Y1; X2;
Y2; H)

Returns the X coordinate of the
point, that lies at the H distance
from the middle point of the vector
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(X1;Y1) - (X2;Y2). If H is a positive
number, this point is to the left of
the vector, if negative - the point is
to the right of the vector. This func-
tion is used to create an arc of the
circle upon two points and the
height of the arc.

_CIRCLES3RD_Y
_CIRCLES3RD _Y(XI;Y1; X2;
Y2; H)

Returns the Y coordinate of the
point, that lies at the H distance
from the middle point of the vector
(X1;Y1) - (X2;Y2). If H is a positive
number, this point is to the left of
the vector, if negative - the point is
to the right of the vector. This func-
tion is used to create an arc of the
circle upon two points and the
height of the arc.

_COMPANYNAME
_COMPANYNAME()

Returns the company name, that
you specify in the Document
Properties (File/Document
Properties).

Example:

"Company: "+ COMPANY-
NAME()="Company: Computer
Systems Odessa corp.”

_00S

_COS(arg)

Returns the cosine of arg (the re-
turned value is within the -1 to 1
range)

_COSH
_COSH(arg)
Returns the hyperbolic cosine of arg.

_Cur

_CUT(arg; iarg)

This fnction discards a number of sig-
nificant digits after the point from arg,
The iarg parameter indicates how many
digits to discard. For negative numbers,
it discards the digits before the point.
Example:

_CUT( 123.4567; 3) = 123.456
_CUT(123.4567;-2) = 100
_CUT(123.4567;0) = 123

_DATE

_DATE()

Returns the string with the current
system date on your computer. The
data format may vary with system
and country.

Example:

_DATE() = 04.09.1999 (Mac)
_DATE() =04 Sep 1999 (Win)

_DEG

_DEG(arg)

Converts arg from radians to degrees.
Example:

_DEG(3.14) =180
_DEG(_PI()*3) =540

_ELLIPSE_ANGLE
_ELLIPSE ANGLE(koeftX; koeffY;
iNumberGeometry; iNumberSeg-
ment)

Returns the inclination of the main
radius of the elli pse with the central
point with (Width*koeffX; Height*
koeffY) local coordinates. Other
parameters, required for building
the ellipse, are taken from the seg-
ment with iNumberSegment number
of the geometry with the iNumber
Geometry number.
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This function is the default formula
for the D column of the EllipseTo
segment in the table.

_ELLIPSE_ASPECT

_ELLIPSE _ASPECT(koeftX; koeftY;
iNumberGeometry; iNumberSeg-
ment)

Returns the ratio between the large
and the small radii of the ellipse
with the central point with
(Width*koeffX; Height*koeffY).
Other parameters, required for
building the ellipse, are taken from
the segment with iNumberSegment
number of the geometry with the
iNumberGeometry number.

This function is the default formula
for the C column of the EllipseTo
segment in the table.

_EVALTEXT

_ EVALTEXT(str)

Converts the string value of str to a
number.

Examples:

_EVALTEXT("123.456 ") = 123.456
_EVALTEXT("123")=123

_FABS

_FABS(arg)

If arg is not zero, returns the abso-
lute value for arg.

If arg equals zero, returns 1.

_ FABS(str)

Returns the string value str without
changing it.

Examples:

_FABS(-3)=3

_FABS(0)=1

_FABS(1)=1

_FABS("Text") = "Text"
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_FILENAME

_FILENAME()

Returns the filename under which
the document is stored.

Example:

_FILENAME() = "Chart.CDD"
_FLOOR

_FLOOR(arg)

Returns the maximal integer
number less or equal arg.
Examples:

_FLOOR( 1234567)= 123
_FLOOR( -45.345 ) = -46
“FLOOR(0) =0

FULLFILENAME
_ FULLFILENAME()
Returns the filename under which
the document is stored with the full
path.
Example:
_FULLFILENAME() =
"D:\ConceptDraw\Chart.cdd"
(Win)
_FULLFILENAME() =
"MyDisk:Desktop Folder:Chart.cdd"
(Mac)

_GRAVITY

_ GRAVITY(Angle; limit1; limit2)
If Angle is more than limit1 or less
than limit2, returns 0.

If Angle is within the [limit1;limit2]
range - returns the pi number.
Normally this function is used for
orientating the text box, so that the
text is readable in whatever position
of the object.

Examples:

_GRAVITY(30deg; 15 deg; 165 deg)
=0
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_GRAVITY(195deg; 15 deg; 165 deg)
_GRAVITY(Angle;-90 deg;90 deg)

_HYP

_HYP(X;Y)

Returns the length of the hypotenuse
of the right-angled triangle with X
and Y legs.

Example:

_HYP(4;3)=35

_IF

_IF(argl;arg2;arg3)

If argl is a non-zero number, or a
non-empty string, the function re-
turns arg2, otherwise - arg3.

Examples:
IF(2>1;3;4)=3
IF(™;3;4)=4
_LG10
_LGI10(arg)
Returns the decimal logarithm of arg.
_IN
_LN(arg)
Returns the natural logarithm of arg.
_LOCALX
_LOCALX(X;Y)

Converts the (X;Y) point from the
global coordinates to local coordi-
nates. Returns the X coordinate for
the resulting point.

_LOCALY

_LOCALY(X;Y)

Converts the (X;Y) point from the
global coordinates to local coordi-
nates. Returns the Y coordinate for
the resulting point.

_MAX
_MAX(argl;arg2)

Returns the largest of the two num-
bers: argl and arg2.
_MAX(arg;str)
_MAX(str;arg)

Returns the number arg (the string
value is ignored).
~ MAX(strl;str2)

Returns the length for the longest
of two strings: strl and str2.
Examples:

_MAX(4;6)=6
_MAX( "Text" ;" Bigtext ") =8
~MAX("Text";7)=7

_MEASURE

_ MEASURE()

Returns the string showing the cur-
rent unit of measure.

Example:

_MEASURE() ="ft"

_MIN

_MIN(argl;arg2)

Returns the minimal of two num-
bers: argl and arg2.

_ MIN(arg;str)

_ MIN(str;arg)

Returns the number arg (the string
value is ignored).

~ MIN(strl;str2)

Returns the length for the shortest
of two strings: strl and str2.
Examples:

_MIN(4;,6)=6
_ MIN( "Text™ ;" Big text ") = 8
_MIN("Text";7)=7
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_MOD

_MOD(argl;arg2)

Returns the excess of argl divided
by arg2

_MOD(str;arg)

_MOD(arg;str)

Returns the number arg if the other
argument is the string str.
_MOD(strl;str2)

Returns zero if both arguments are
strings.

Examples:

_MOD(19;6)=1

_MOD( "Text"; "Big text") =0
_MOD("Text";7) =7

_NOT

_NOT(arg)

If arg is zero or an empty string,
returns 1.

Otherwise returns 0.

Examples:

_NOT(0)=1

_NOT(123)=0

_OR

_OR(argl;arg2)

Returns bitwise OR;

_OR(strl;str2)

Returns 1 - if at least one of the

strings is non-empty, 0 - if both

strings are empty.

_OR(str;arg)

_OR(argstr)

Returns the number arg.

Examples:
_OR(1;0)=1
_OR("Hello!"; ™) =1
_OR("Text1"; "Text2") =1
_OR("Text";2) =2
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_PAGEHEIGHT
_PAGEHEIGHTY)

Returns the height of the document
page. Note, that the page size is set
in the Document Properties dialog,
under the Page tab.

_PAGENAME

_PAGENAME()

Returns the name of the page to which
the object belongs. You can set the
name in the Page Properties dialog.

_PAGENUMBER

_ PAGENUMBER()

Returns the number of the page to
which the object belongs..

_PAGESCOUNT
_PAGESCOUNT()

Returns the number of pages in the
document.

_PAGEWIDTH

_PAGEWIDTH()

Returns the width of the document
page. Note, that the page size is set
in the Document Properties dialog,
under the Page tab.

Pl
_PI)
Returns the pi number.

_POW

_POW(argl;arg2)

Raises argl to a power of arg2.
_POW(str;arg)

_POW(arg;str)

Returns the arg number if the other
argument is a string.
_POW(strl;str2)
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Returns zero if both arguments are
strings.

Examples:

_POW(2;3)=8

_POW("Text" ; " Bigtext ") =0
_POW("Text";7)=17

_RAD
_RAD(arg)
Converts arg from degrees to radians.
Examples:
_RAD(90)=1.57

_RAND

_RAND()

Returns a random value within the 0
to 32K range.

_ROUND

_ROUND(arg; iarg)

Returns arg approximated to iarg
digits after the point.

Examples:

_ROUND( 123.4567; 3) = 123.457
_ROUND(123.4567;-2) = 100
_ROUND(123.67;,0) =124

_SCALE

_SCALE()

Returns a string describing the cur-
rent scale of the document in the
"N : M" format.

Examples:

_SCALE()="1:1"
_SCALE()="4in: 1 ft"

_SEIF

_SETF(str; arg)

_ SETF(str; strarg)

This function changes the values in
the table cells. String str specifies
the name of the cell, where to put

the data. The arg parameter must
contain the new value for the cell.
The strarg parameter must contain
the string with a new formula for the
cell

Examples:

_SETF( ’Geometryl.X2"’;
”Geometry2.X3/2 + Geometry3.X2/
4)

_SETF(’Width” ; 125 cm)

_SIGN

_SIGN(arg)

Returns the sign of arg:
-1, if arg<0,

1, ifarg>0

0, if arg=0

Examples:
_SIGN(123.4567)=1
_SIGN(-123.4567 ) =-1
_SIGN(0)=0

_SIN

_SIN(arg)

Returns the sine of arg (the returned
value is within -1 to 1 range).

_SINH
_SINH(arg)
Returns the hyperbolic sine of arg .

_SQRT

_SQRT(arg)

Returns the square root from arg.
The resulting value is undefined for
negative numbers.

TAN

_TAN(arg)
Returns the tangent of arg.
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_TANH

_TANH(arg)

Returns the hyperbolic tangent of
arg

_TEXTHEIGHT
_TEXTHEIGHT str; arg)

This function calculates the height
of the text block, when arg is
assigned as its width. The str
parameter is usually the contents
of text field of the object (the
TheText field in the table). When
calculating the height, this function
considers all the current text settings
for the object (styles, indents and
margins, etc).

Examples:
_TEXTHEIGHT(TheText; Width)
_TEXTHEIGHT(TheText;2 in)

_TEXTLEFT

_TEXTLEFT(str; iarg)

Returns first iarg characters of the
str string.

Example:

_TEXTLEFT( "A big text."; 5) =
"Abig"

_TEXTLENGTH
_TEXTLENGTH(Gstr)

Returns the length of the str string
(the number of characters in the
string).

Example:
_TEXTLENGTH("Abigtext.") =11

_TEXTRIGHT
_TEXTRIGHT (str; iarg)

Returns last iarg characters of the
str string.

Example:
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_TEXTRIGHT( "A big text"; 4) =
"text"

_TEXTWIDTH
_TEXTWIDTH(Gstr)

Returns the width of the str string
considering all current text settings
of the object (styles, indents and
margins, etc.). Normally, this func-
tion is used to make the text box the
same width as the width of the long-
est string in the object's text.
Example:
_TEXTWIDTH(TheText)

_TIME

_TIME()

Returns current system time in
the "hours:minutes:seconds"
format.

Example:

_TIME() ="19:27:13"

_TITLE

_TITLE()

Returns the title of the document.
The title is specified in the
Document Properties dialog, the
General tab.

_VALTOTEXT
_VALTOTEXT (arg)

Converts the arg number into a string
and returns the string.

Example:

_VALTOTEXT( 567.89 ) ="567.89"

_VALTOTEXTMES
_VALTOTEXTMES(arg)

Converts the arg number into a string
considering the currently used units
of measure.
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Examples:
_VALTOTEXTMES(15)="1/16"
_VALTOTEXTMES(1.5in)+"in."=
"11/2in."

_WORLDX

_WORLDX(X;Y)

Converts the (X;Y) point from local
coordinates to global coordinates.
Returns the X coordinate for the
resulting point.

_WORLDY

_WORLDY(X;Y)

Converts the (X;Y) point from local
coordinates to global coordinates.
Returns the Y coordinate for the
resulting point.

_XOR

_XOR(argl;arg2)

Returns the bitwise XOR.

_ XOR(strl;str2)

Returns 1 - if only one string is not
empty; 0 - if both strings are empty,
or both are not empty.

_ XOR(str;arg)

_ XOR(arg;str)

Returns the arg number.

Examples:

_XOR(1;1)=0

~ XOR("Text1";"Text2") =0
_XOR("Text";2) =2
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Chapter 8 Working with other program
(OLE) E

ConceptDraw is an OLE-compatible program (supports Object Linking and
Embedding). Due to this feature, you can use your ConceptDraw objects in

other OLE-compatible programs, as well as work with other programs' objects
from within ConceptDraw.

OLE-compatibility means that you can combine objects created in different programs,
such as pictures, audio and video files, and others, within a single document.

Linking
You can link data from another programs to your document. When you link to
another program's object, your document stores not the linked object itself,

but only a reference to the location where its file resides. When you change the
original data file, all changes are reflected in your document.

To modify a linked object, call its context menu. The Linked <Application>
Object menu item includes a submenu osf actions you can perform on the
linked objects: Edit and Open. Click any to launch the <Application> program,
where you can edit the linked object.

1t's usually enough to double-click an OLE object to
launch its editing program.

Embedding

You can embed objects, created in other programs into your Concept Draw
document, and use Concept Draw objects in other programs - for instance,
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illustrate your Word documents with Concept Draw drawings. All embedded
data is stored with the document, even if it the original file exists.

To modify an embedded object, right-click it. The lower item on the context
menu includes a submenu of actions you can perform on the embedded object:
Edit and Open. Click any to launch the object's application, where the object
can be edited.

1t's usually enough to double-click an OLE object to
launch its editing program.

Inserting a new OLE object

If there are other OLE-compatible programs on your system, you can insert
their new, empty objects in your Concept Draw document, and then edit
them from within Concept Draw.

To do this, make the following steps:

- Choose Object under the Insert menu. The Insert Object dialog will open.

- Choose Create New to create a new object.

- From the Object Type list, choose the type you want. If there's no such type
in the list, it's possible that the corresponding application is not installed on
your system.

- If you only want the object to be displayed as icon, choose Display As Icon
option.

- Click OK.

You'll get into the new object editing window. To finish editing, click away
from the object (if you're in the ConceptDraw window), or choose File/
Exit & Return to ConceptDraw (if the OLE-application opened in a new
window).

Editing an OLE object

152

To edit an OLE object, that already exists in your document, call the context
menu for the object. A new submenu will appear at the bottom of the menu -
its exact name varies with the type of the chosen object (for instance, for
Microsoft Word objects it's called Document Object). It includes two options:

-Edit - to edit the object from within ConceptDraw.
-Open - to open the object's application in a new window and edit the object
there.
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After you choose an item, the editing starts. To finish editing, click away from
the object (if you are within Concept Draw window), or choose File/Exit &
Return to Concept Draw (if you're in the object's is program).

1ts usually enough to double-click an OLE object to
launch its editing program.

Inserting an object from a file

You may open an existing OLE-compatible file that contains the object you
want to insert in ConceptDraw. To do this:

- Choose Insert/Object from the menu. Insert Object dialog box will open.
- Choose Create From File option.
- Click Browse.
- Select a file, that you want to insert in your document.
- If you choose the Link option, the object in the file will be stored apart
from the document and all changes, made in the object file will reflect on
your document. Otherwise, the object will be embedded and stored with the
document
- If you want the object displayed as icon only, choose Display As Icon option.
- Click OK.
Dragging a file from Explorer into ConceptDraw has
the same effect as inserting OLE object from the file
with the Display As Icon option chosen.

Inserting an object fromn an open OLE-
compatible program

If you want to insert in your ConceptDraw document an object from an already
running OLE-compatible program, do the following:

- Copy the object on the Clipboard.
- In ConceptDraw, open the document in which you want to insert the object.
- From the Edit menu, choose Paste Special.

You may also use the Drag & Drop functionality for inserting OLE objects.
Select the object in the OLE-compatible application, drag it into the open
ConceptDraw window and drop it there. The result will be the same as if you
used the Paste operation.
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Creating a new ConceptDraw object in

an

OLE-compatible program
You can create ConceptDraw objects staying within another OLE-program.

Do the following:

- In the OLE-compatible program, open the document, where you want to
insert a ConceptDraw object.

- On the Insert menu, choose Object. Insert Object dialog box will open.

- Choose Create New option.

- From the list of available object types, choose ConceptDraw Document.

- If you want the object to be displayed as icon only, choose Display As Icon
option.

- Click OK.

You'll start editing the new object in the ConceptDraw window. To get back to the
primary application, on the File menu click Exit & Return to <Application Name>.

Editing a ConceptDraw object within
another OLE-compatible program.

To modify a ConceptDraw object within another OLE-compatible program,
right-click the object to get its context menu. The ConceptDraw Document item
gives you the choice of two actions: Edit or Open. Choosing any of them turns
the object editing mode on. To finish editing, choose Exit & Return to
<Application Name> under the File menu.

1t's usually enough to double-click an OLE object to
launch its editing program.

Inserting an object from a ConceptDraw
file into other OLE-compatible programs.
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You can insert objects stored in ConceptDraw files in other OLE-compatible

programs.
To do this, in the OLE-compatible program

- From the Insert menu, choose Object. The Insert Object dialog will open.
- Choose Create From File option.
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- Click Browse.

- Select the ConceptDraw file (a .cdd file) that you want to insert in the
document.

- If you choose the Link option, the object in the file will be stored apart from
the document and all changes, made in the object file will reflect on your
document. Otherwise, the object will be embedded and stored with the docu-
ment

- If you want the object to be displayed as icon only, check Display As Icon
option.

- Click OK.

Inserting an object from an open
ConceptDraw document info another
OLE-compatible program.

If you have an object in an open document, that you want to insert in another
OLE-compatible program, do the following:

- Select the object.

- From the Edit menu, choose Paste or Paste Special.

- In the target program, open the document where you want to insert the object.
- From the Edit menu, choose Paste Special.
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Appendix A Keyboard Shortcuts
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Document

=
CtrHN
Ctr+0

Ctd+S
Ctrl+P

Windows

= ||

Ctrl+F4

Ctrl+Tab or Ctrl+F6
Ctrl+"+"

Ctrl+"-"

B

B

Undo/Redo
=

Ctrl+Z or Alt+BkSp
Ctri+Y

4
Cmd+N
Cmd+O

Cmd+S
Cmd+P

Kl
CindHW
CndH"+"
Cmd+""
B

B

4
Cmd+Z
Cmd+Y

Action

Create New Document

Open
Document/Template/Workspace
Save Document

Print document

Action

Close current window

Set next window as active
Zoom In

Zoom Out

Show Table

Show/Hide Library Window

Action
Undo last action
Redo
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Edit

= K Action

Ctrl+X or Shift+Del ~ Cmd+X Cut onto the Clipboard

Ctrl+C or Ctrl+Ins Cmd+C Copy onto the Clipboard
Ctrl+V or Shift+Ins CmdtV Paste from the Clipboard
Ctrd+Shift+V Cmd-+Shift+V Paste into position

Del Del or Delete Delete selected object

Ctrd+D Cmd+D Duplicate object

Ctr+B Cmd+B Send To Back

Ctrl+F Cmd+F Bring To Front

Ctrd+Shift+B Cmd-+Shift+B Send To Step Back
Ctr+Shift+F Cmd+Shift+F Bring To Step Front

Ctrl+L Cmd+L Rotate Left (90 degrees)

Ctd+R Cmd+R Rotate Right (90 degrees)
Ctrd+J Cmd+t] Flip Vertical

Ctr+H Cmd+H Flip Horizontal

Cti+G Cmd+G Group

Ctd+U Cmd+U Ungroup

Cti+E Cmd+E Edit Group

Ctrd+Shift+E Cmd+Shift+E Edit hyperlink

Ctrl+Shift+H Cmd+Shifi+H Open hyperlink

Selecting

= K Action

Ctrl+A CmdHA Select all objects on page

Tab Tab Select next object in the order list
Shift+Tab Shift+Tab Select previous object in the
order list

Help

= K Action

H Help or F1 Call Help.

ConceptDraw 157



158

Switching between tools

= |
Ctrl+1
Ctr+2
Ctr+3
Ctrl+4
Ctr+5
Ctrl+6
Ctrl+7
Ctr+8
Ctr+9
Ctr+0
R

Space
Library

=
Ctrl+Shift+Click

Ctrl+Shift-+i

Table

= |
R

4]

Enter, Ctrl+1
Ctrl+2
Ctrl+3
Ctrl+4
Ctrl+5
Ctrd+6
Ctrl+7
Ctrl+8
Ctrd+9
Ctrd+0
B

Space

]
Cmd-+Shift+Click

Cmd+Shift+i

In the editing mode, clicking another cell:

single click
Ctrl+click

Alt+click

(Cmd-+click)

Action
Activate Select tool
Activate Rotate tool
Activate Line tool
Activate Sector tool
Activate Arc tool
Activate Spline tool
Activate Rectangle tool
Activate Ellipse tool
Activate Connector tool
Activate Connection Point tool
Activate Edit Text tool
Activate Scroll Hand Tool

Action

Swap objects in the library.

One of the object must be selected.
Replace the selected object in the
library with the object selected in
the document, maintaining

the library object's icon.

Action
starts editing the selected cell.

inserts the formula from the cell
you clicked into the input field.
inserts the numeric value of

the cell into the input field.
inserts the cell title into the input
field.

ConceptDraw



Edit text

=
Ctd+B
Ctrl+1
Ctl+U

Ctl+L
Ct+E
Ct+R
Ctrl+">"
Ctrl+"<"
Ctrl+F
Ctd+S
Esc

K Action

Cmd+B Bold

Cmd+I Italic

Cmd+U Underline
Cmd+O Outline

Cmd+S Shadow

Cmd+C Condense
Cmd+L Align on the left
Cmd+E Align on the center
Cmd+R Align on the right
Cmd+">" Increase font
Cmd+'<" Decrease font

- Select font

- Select font size
Esc, Enter Finish editing

Manipulations With The Keyboard

=
Arrows
Shift + Arrows

Ctd+LeftArmow
Ctr+RightArrow
Ctrl+Shift+LeftArrow
Ctrl+Shifti+RightArrow

= |

PgUp
PeDn
Ctrl+Home
Ctrl+End
Ctrd+PgUp
Ctri+PgDn

ConceptDraw

E Action

Arrows Move selected objects or handles.
Shift + Arrows  Move to next grid node.
Cmd+LetfAmow  Rotate by 1 degree counterclockwise
Cmd+RightArmow Rotate by 1 degree clockwise
Cmd+Shiff-H effAnow Rotate by 0.1 degree counterclockwise
Cmd+Shifi-+H effAnmow Rotate by 0.1 degree clockwise

E Action

PegUp Scroll one window up;

PeDn Scroll one window down;
Cmd+Home Go to the top-left comer of the page;
Cmd+End Gotothebottom-left comerofthe page.
Cmd+PgUp Go to previous document page;
Cmd+PgDn Go to next document page.
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Working with the mouse.

-Clicking objects with the Shift key held down selects each object you click.

-Rotate with Ctrl(Cmd) - rotate around common rotation centre.

-Resize with Shift - toggle between unproportional and proportional resizing.

-Drawing with Shift held down - constrained drawing mode.

-InsertVertex with Ctrl(Cmd) - cut line in this place.

-Stamp with Shift: for 2D objects - proportional resize; for 1D objects -
invert connector's direction.

-Ctrl(Cmd), Shift for Connection Point and Edit Text tools - allows to
select objects.

-Clicking on the alignment box of the object switches between the Select
and Rotate tools.

-Dragging an object with the Ctrl(Option) key held down copies the object.

-Holding down the Alt(Cmd) key inverts the Snap mode.

-Esc when moving, resizing or dragging an object - cancels the operation.
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Appendix B  Brief Menu Tour

«File» Menu ltems

Edit Y¥iew Insert Format Figure Page T

Browse Templates...

Mew Library Drawing aeN

Open... F#E0

Open Library...

Close FW Mg T 1Y

Save #5 P untitled - Page-1=
Save As... 2

|i5|||||||3||||||||3i5||||||4|.||||||

Save Copy As...
Save As Template...
S5ave Workspace...
Revert

Import...
Export...

Print... 3P
Print Preview...
Page Setup...

Send
Document Properties...

Open Recent 2
Quit 0
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New->Browse Templates

Creates a new document from template.

Please refer to the Creating a new document from a template section for more
detailed information.

New->Document
Creates a new document.
See the Creating a new document section for more information.

Open

Opens an existing document. Also lets you open other ConceptDraw files:
templates, libraries, workspace files.

For more specific information, please refer to the Opening a document,
Opening a library, Creating a new document from a template, Opening documents
and libraries by using the workspace sections.

New Library
Creates a new library.
See the Creating a new library section for details.

Open Library
Opens an existing library.
See the Opening a library section for specifics.

Close
Closes the active document.

Save

Saves the active document.

Please refer to the Saving a document (Save, Save As, Save Copy As) section for more
information.

Save As

Saves the active document under a new filename.

Please refer to the Saving a document (Save, Save As, Save Copy As) section for
more information.

Save Copy As

Saves the copy of document under a new filename.

Please refer to the Saving a document (Save, Save As, Save Copy As) section
for more information.
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Save As Template
Saves/creates a template file.
For specifics, refer to the Creating a template file section.

Save Workspace
Saves/creates a workspace file
For specifics, refer to the Saving a workspace file section.

Export

This option saves the document or a group of selected objects in a graphic
format, or as an HTML file.

Please refer to the Exporting files section for more specific information.

Import

Opens picture files of various graphic formats.
Please refer to the Importing files section for more specific information.

Print Preview
Lets you view - prior to actual printing - how the document will print out.
For specifics, refer to the Previewing the document section.

Print
Prints the document.
Please refer to the Printing section for more specific information.

Page Setup
Selects the paper size, orientation and some other printer settings.
Please refer to the Printer setup section for more specific information.

Send

Sends the document via e-mail.

Please refer to the Sending a document by e-mail section for more specific
information.

Document Properties

Displays a dialog box, where you can specify the document name, size and
orientation of the document’s pages, scale, measurement system and other
parameters.

For specifics, please refer to the Document Properties dialog (General, Page,
Settings, Printing) section.
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Recent Files i
Shows a list of the four most recent documents you’ve worked with in
ConceptDraw. Clicking on a document name will reopen it.

Open Recent
Lets you select one of the ten most recent documents you’ve worked with
from the drop-down list. Clicking on the document name will reopen it.

Exit
Closes all opened documents and exits ConceptDraw. If you haven’t saved

changes you’ve made to a document, the program will offer you to save the
document before exiting.

«Edit» Menu ltems

Can't Undo E
Can't Redo #EY
Cut 3BX
Copy 3EC
Paste £

Paste From Clipboard

Put Into Library
Replace Library Object

Delete

Select All EA
Duplicate 3D
Preferences...

Undo
Reverses the last operation you performed.
See the Undo and redo operations section for details.

Redo
Reverses the last Undo operation.
See the Undo and redo operations section for details.

Cut

Removes selected objects or text and places them on the Cli pboard.
Please refer to the Undo and redo operations section for more specific
information.
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Copy

Copies selected objects or text and places them on the Clipboard.
Please refer to the Undo and redo operations section for more specific
information.

Paste

Pastes the contents of the Cli pboard onto the document

Please refer to the Undo and redo operations section for more specific
information.

Paste Special = ||

Inserts the contents of the Clipboard onto the document, letting you specify
the format in which the pasted object will be stored. This option is mostly
used for inserting OLE-objects.

For specifics, refer to the Inserting an object from an open OLE-compatible
program section.

Paste From Clipboard [
Takes the contents of the Cli pboard and inserts it into the document as a
picture.

Put Into Library

Copies selected object from the document into the library.

For specifics, refer to the Adding an object from the document to a library
section.

Replace Library Object

Replaces a selected library object with a new one without changing the icon.
For more information refer to the Replacing an object under an existing
library icon section.

Delete
Deletes selected objects or handles.
See the Deleting objects section for details.

SelectAll
Selects all objects on the active page of the document.

Duplicate
Duplicates selected objects.
See the Duplicating objects for specifics.
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Object |
Starts editing selected OLE-object.
Please refer to the Editing an OLE object section for specifics.

Preferences

Brings up the dialog where global environment properties can be set:
measurement units, page size for all new documents, path to libraries and
samples, supplied with the program, etc.

Refer to the "Program configurations" section for more detailed information.

«View» Menu ltems

Toolbhars... v ,«\P -
Zoom In |
Zoom OQut |
T - 100%
Last Zoom 2009
Actual Size 1902
Page Width 1299
Whole Page 1002
+ Rulers 3%
v Grid 0%
' Guides
+ Connection Points
Connection Points In Groups
Page Breaks o
+ Libraries
Lavers Properties...

Toolbars
Displays a dialog, where you can choose which toolbars to show.

Zoom In
Magnifies the document for detailed editing.
Refer to Zooming for more specific information.

Zoom Out

Reduces the document and lets you see and work with more of the
document at one time.

Refer to Zooming for more specific information.
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Zoom
Lets you choose one of the zoom levels within the 50% - 400% range from the
submen

Last Zoom
Returns the document to the last zoom setting.

Actual Size
Sets zoom to 100%.

Page Width
Sets the zoom level so that the page width fits in the window.

‘Whole Page
Sets the zoom level so that the entire page fits in the window.

Rulers
Shows/hides the rulers.

Grid
Shows/hides the background grid.

Guides
Shows/hides the guide lines.

Connection Points
Shows/hides the connection points of objects.

Connection Points In Groups
Shows/hides the connection points of objects in groups.

Page Breaks
Shows/hides non-prinable areas of the document pages.

Libraries
Shows/hides the library window.

Layer Properties

Displays the dialog, where you can modify the layer properties. There you
may name a layer, specify whether a layer is visible, active, or locked,
change the layer color.

More detailed information can be found in the Working with layers section.
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«Insert» Menu ltems

Picture...
Hyperlink...
Object...

Picture
Imports a picture and inserts it into the document.
See the Pictures section for specifics.

Hyperlink

Assigns a hyperlink to the selected object. You can use this hyperlink to jump
to another page of the document, open a document, launch an application,
open an Internet page in the browser.

For specifics, please refer to the Hyperlink section.

Object E
Inserts OLE-object into the document.
Please refer to the Working with other programs (OLE) section for details.

«Format» Menu ltems

Fill & Shadow...
Text...

HyperLink 4 Open
Protection... Lé
Double-Click... Un
Set Laver... E

Behaviour...
Information...

Line... A\P =y o

Line

Displays the dialog box, where you can change the line properties of the
selected object, and apply arrowheads to the line ends.

See the Line Properties section for more specific information.

Fill&Shadow

Displays the dialog, where you can change the fill colors for the object and its shadow.
Refer to the Fill patterns and colors and Shadows sections for more specific
information.
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Text

Brings up the dialog, where the properties of the selected text block can be
set. In the dialog, you may select the font, font size, fond color and style,
margins and indentation.

Refer to the Text Properties dialog box section for more specific information.

Hyperlink->Open

Follows the hyperlink associated with the selected object. Depending on the
hyperlink type, this command can open a page of the document, open another
document, launch an application, or open an Internet page in an available
browser.

For more specific information, refer to the Hyperlink section.

Hyperlink->E dit
Opens the dialog where hyperlink properties can be edited.
For more specific information, refer to the Hyperlink section.

Hyperlink->Remove
Removes the hyperlink associated with the selected object.

Protection

Displays the Protection dialog, where you can lock some properties of the
selected object against being changed: for instance, the width, height, angle
and other.

Please refer to the Protection section for specifics.

Double-Click
Assigns the double-click action to the object.
See the Double click section for details.

Set Layer
Moves selected objects onto another layer.
For more specific information, refer to the Working with layers section.

Behaviour

Opens the Behaviour dialog box, where you can specify whether the
object is 1-Dimensional or 2-Dimensional. Here you may also set how
the object behaves when resized, show/hide its alignment box and
handles.

Please see the Behaviour section for more detailed information.
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Information

Calls the Information dialog, where you can name and describe the selected
object.

See the Information section for specifics.

«Figure» Menu Items

Send To Back #B Sl (TTome -

Bring To Front 38F
Send To Step Back
Bring To 5tep Front

Rotate Left {903 36L ‘:'ii- t¥ % a

Rotate Right (90) #R | page-1=>=

Flip Horizontal 3EH 12

Flip Yertical 1

Edit Text

Show Table

Group i )

Ungroup £

Edit Group 3BE

Operations Combine
Join
Scattering

Send To Back

Sends selected objects to the back of the order list.

Please refer to the Changing the display order of objects section for more
detailed information.

Bring To Front

Bring selected objects to the front of the order list.

Please refer to the Changing the display order of objects section for more
detailed information.

Send To Step Back

Positions selected objects one step lower in the order list.

Please refer to the Changing the display order of objects section for more
detailed information.
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Bring To Step Front

Positions selected objects one step higher in the order list.

Please refer to the Changing the display order of objects section for more
detailed information.

Rotate Left (90)
Rotates selected objects 90 degree counterclockwise.
See the Rotating objects for more details.

Rotate Right (90)
Rotates selected objects 90 degree clockwise.
See the Rotating objects for more details.

Flip Vertical
Creates vertically mirrored copies of the selected objects.
Please refer to the Flipping objects section for specifics.

Flip Horizontal
Creates horizontally mirrored copies of the selected objects.
Please refer to the Flipping objects section for specifics.

Edit Text
Turns on the text editing mode for the selected object.
For specifics, refer to the Modifying text in an object section.

Show Table

Open the selected object’s parameter table in a separate window.

For more specific information, please refer to the Working with the table
section.

Group

Creates a group of selected objects into a single unit.
For more specific information, please refer to the Grouping objects section.

Ungroup
Ungroups the selected grouped unit.
For more specific information, please refer to the Grouping objects section.

Edit Group

Opens a new window, where you can edit inside the selected grouped unit.
For more specific information, please refer to the Grouping objects section.
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Operations->Combine

Combines several selected objects into one object. Each object is converted
into a separate geometry.

Please refer to the Combine section for specifics.

Operations->Join

Joins several selected objects so they form a single object. As the result of this
operation, all geometries with coinciding ends are considered as one solid
geometry.

Please refer to the Join section for specifics.

Operations->Scattering
Forms an individual object for each geometry of the selected object.
Please refer to the Scattering section for specifics.

«Page» Menu Items

Add...
Delete...
Reorder...
Go To...

Properties...

Add
Adds a new empty page to the active document.
See the Adding a page section for details.

Delete
Removes the selected page of the document.
See the Deleting a page section for details.

Reorder
Allows you to rearrange pages in the active document.
For specifics, refer to the Reordering pages section.

GoTo
Activates the specified page.
For specifics, refer to the Jumping to another page section.

Properties
Lets you rename the page.
Please see the Naming a page section for details.
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«Jools» Menu ltems

Centre Page
Centre Yertically
Centre Horizontally

Color Palette...

Grid...
Shap and Glue...

Centre Page
Positions selected objects in the centre of the page.

Centre Vertically
Positions selected objects in the centre of the page vertically.

Centre Horizontally
Positions selected objects in the centre of the page horizontally.

Color Palette
Allows to modify, load or save the color palette of the active document.
For specifics, refer to the Color Palette section.

Grid

Displays the dialog where the grid properties of the active document can be
modified. Here you can set the grid spacing, its origin, etc.

Please see the Grid section for details.

Snap&Glue
Calls the dialog where snapping and gluing properties can be set up.
Refer to the Snapping and gluing section for more detailed information.

Options

Brings up the dialog where global environment properties can be set:
measurement units, page size for all new documents, path to libraries and
samples, supplied with the program, etc.

Refer to the Program configurations section for more detailed information.
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«Window» Menu ltem

Mew Window
LCascade

Tile

Cloze All

v 1 ConceptDraw] - Page-2

New Window
Opens a new window with the active document. It’s a useful feature when
you’re editing a page, but need to see its original copy at the same time.

Cascade e |

Arranges all open windows so that each next window appears slightly down
and to the right from the previous one. This way you can access each
window quickly.

Tile i
Resizes and rearranges all open windows so that they don’t overlap one
another.

Close All
Closes all open windows of the program, offering you to save all unsaved data.

«Help» Menu Item

CorceptDraw Help la m e =1l @ @

ConceptDraw On the Web  # ConceptDraw Web Site

About ConceptDiraw. . Bengizter Haow
ConceptDraw Help

Calls ConceptDraw Help. This opens a separate window, where you can see a
number of articles containing information on how to use the product. You
may read or print the articles, search them for necessary information.

ConceptDraw On the Web -> ConceptDraw Web Site

Launches your Internet browser and goes to the ConceptDraw web site:
http://www.conceptdraw.com/
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ConceptDraw On the Web -> Register Now
Registers the program owner on the ConceptDraw web site:
http://www.conceptdraw.com/Register/

About ConceptDraw = ||

Displays general information about the program: the title, version number,
copyright information.
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Index

Symbols

_ABS 142 _HYP 146

_ACOS 142 _IF 146

_AND 142 LGI10 146
_ANG360 142 LN 146

_ASIN 142 _LOCALX 146
_ATAN 143 _LOCALY 146
_ATAN2 143 ~MAX 146
_AUTORNAME 143 _MEASURE 146
_CENTERX 143 ~MIN 146
_CENTERY 143 ~MOD 147
_CIRCLE_CENTERX 143 _NOT 147
_CIRCLE_CENTERY 143 _OR 147
_CIRCLES3RD X 143 _PAGEHEIGHT 147
_CIRCLES3RD Y 144 _PAGENAME 147
_COMPANYNAME 144 _PAGENUMBER 147
_COS 144 _PAGESCOUNT 147
_COSH 144 _PAGEWIDTH 147
_CUT 144 _PI 147

_DATE 144 _POW 147

_DEG 144 _RAD 148
_ELLIPSE_ANGLE 144 _RAND 148
_ELLIPSE_ASPECT 145 _ROUND 148
_EVALTEXT 145 _SCALE 148

_FABS 145 _SETF 148
_FILENAME 145 _SIGN 148
_FLOOR 145 _SIN 148
_FULLFILENAME 145 _SINH 148
_GRAVITY 145 _SQRT 148

176 ConceptDraw



_TAN 148

"TANH 149
_TEXTHEIGHT 149
_TEXTLEFT 149
_TEXTLENGTH 149
_TEXTRIGHT 149
_TEXTWIDTH 149
"TIME 149

"TITLE 149
_VALTOTEXT 149
“WORLDX 150
“WORLDY 150
“XOR 150

A

Action 140
Actions section 140
Align Figures 34
AlignBox 139
Angle 124

ArcTo 126
ArrowSize 132

B

BeginArrow 132
BeginX 127

BeginY 127
Behavior dialog 53
BringToFront 42
BringToStepFront 43

C

Cells 119
Centre Horizontally 173
Centre Page 34
Centre Vertically 173
Changing the order in which objects
are displayed 42

Character Format section 136
Checked 141
Closing

document 16

library 113
Color 136
Color Palette 87

ConceptDraw

Color Palette dialog 87
Combine 57
Comment 130
Connect Figures tool 62
Connect section 130
Connection
to a connection point of the object
60
to the entire object 60
Connection points 63
Connector
object 61
smart 61
Constrained drawing mode 25
Control handles 29
Controls section 128
Creating
figures 25
new document 13
new document from template 13
new library 14, 113
template 16
CtrlHandles 140
Cut 77

D

Deleting an objects from a library 117
Deleting objects 43
Direct Connect tool 62
Direct Connector tool 62
Disabled 141
Distribute Figures 35
Document
closing 16
creating 13
creating from template 13
measurements 86
opening 15
printing 93
saving 16
scaling 86
sending by e-mail 17
zooming 79
Document Properties dialog 89
Double click dialog 52
Duplicating objects 44

177



E

Edit Group 45

Ellipse 26

EllipseTo 126

Embedding 151

EndArrow 132

Endpoints section 127
EndX 127

EndY 128

Export to HTML format 20
Exporting files 19

F

Figure

creating 25

overview 23
File extensions 13
Fill & Shadow dialog 48
Fill Format section 133
Fill patterns and colors 48
FillBackgnd 133
FillForegnd 133
FillPattern 133
Firstind 137
Flip Horizontal 41
Flip Vertical 41
Flipping objects 41
FlipX 124
FlipY 124
Font 136
Formulas 120

G

Geometry 23
Geometry section 124
Glueing 83

Grid 80

Grouping objects 44
Guide lines 82

H

HAlign 137

Handles
connection points 30, 63
control 29

178

endpoints 28

overview 27

resize 27

rotation 27

vertices and adjustment handles 28
Height 123
Hyperlink dialog 55

I

Importing files 18
Information dialog 53
Input field 119

Insert Vertex 57

Installing ConceptDraw 11

J
Join 58

K
Keyboard Shortcuts 156
L

Layers 102
LeftInd 137
Libraries
overview 110
Library
closing 113
creating 14, 113
files allocation 112
objects
adding from the document 115
copying between libraries 116
deleting 117
displaying as icon and as text 114
inserting into your document
115
properties 114
replacing (keeping the old icon)
117
opening 15, 112
properties 113
saving 113
Line Properties dialog 46
Line Properties section 132
LineColor 132
ConceptDraw



LineStyle 132
LineTo 126
LineWidth 132
Linking 151
LockAspect 134
LockBegin 135
LockCalcWH 134
LockDelete 134
LockEnd 135
LockHeight 134
LockMoveX 134
LockRotate 134
LockVertex 135
LockWidth 134
LocPinX 124
LocPinY 124

M

Make Same 39

Make Same Style 50

Measurements 86

Menu 141

Miscellaneous section 139

Moving objects
constrained 34
overview 33
with the keyboard 33
with the mouse 33

N
NonPrinting 140
(0

Objects

operations
deleting 43
duplicating 44
flipping 41
grouping 44
moving 33
resizing 37
rotating 36
selecting 30

types
connector 24, 59
figure 23

ConceptDraw

group 24
OLE 24
picture 24, 65
ObjHandles 139
OLE
Creating a ConceptDraw object 154
Editing a ConceptDraw object 154
Editing an OLE object 152
Embedding 151
Inserting a new OLE object 152
Inserting an object from a
ConceptDraw file 154
Inserting an object from a file 153
Inserting from an open OLE-
compatible program 153

Linking 151
overview 151
Opening

document 15

library 15, 112

workspace 16
Options dialog 106
OriginX 124
OriginY 124

P

Pages
adding 99
deleting 100
global properties 97
jumping to another page 101
naming 102
overview 97
printing 98
reordering 100
Paragraph section 137
Paste 77
Pictures
overview 65
Printing documents
arranging on pages 93
previewing 95
Printer setup 96
Printing 94
Program configuration 106
Prompt 141
Properties. X 125

179



Properties.Y 126 elliptical 26

Protection dialog 51 linear 25
Protection section 134 of circle 25
spline 26
R transforming 28
Rectangle 26 Select.All 31
Redo 76 Selecting
Registration 12 in .the order they were created 32
ResizeBehavior 140 objects 30
Resizing objects in a group 32
ObjeCtS 37 SendToBack 42

SendToStepBack 43
ShadowBackgnd 133
ShadowForegnd 133
ShadowPattern 133
Shadows 49
ShowText 140

objects within a group 39
RightInd 137
Rotate Left 37
Rotate Right 37
Rotating objects 36
Rotation center 36

Rulers 81 Snap&Glue dialog 83
Snapping 83
S SplineKnot 127
SplineStart 127
Save Copy As 16 Start dialog 17
Saving Style 136
document 16 System requirements 10
library 113
workspace 17 T

Scaling document 86

Scattering 59 Table

Scroll Hand Tool 83 overview 118

Sections Technical support 11
Actions 140 Template

create a new document from

Character Format 136
template 13

Connect 130

Controls 128 creatipg 16

Endpoints 127 overview 104

Fill Format 133 transporting 105
Text

Geometry 124
Line Properties 132
Miscellaneous 139
overview 121

adding to a new object 67
alignment 69
autoexpand 76
Paragraph 137 changing styles 68

Protection 134 creating 67 ,
Text Field 139 cutting, copying and pasting 70

Text Transform 135 @n group 75 .
Transform 122 indents and margins 71
Variables 131 modifying in an object 67

Segments of smart connector 76

180 ConceptDraw



overview 66
Text Box 70
Text Box tool 66
Text Field section 139
Text Properties dialog 72
Text Transform section 135
TextAngle 135
TextHeight 135
TextOriginX 135
TextOriginY 136
TextPinX 136
TextPinY 136
TextWidth 135
Transform section 122

U

Undo 76
URL Autoparsing 55

\

Variables section 131
Vertices
adding 29, 57
deleting 29
moving 29
overview 28
selecting/unselecting 29

W

Width 123
Working with layers 102
Working with other programs (OLE)
151

Working with text 66
Working with the table 118
Workspace

opening 16

overview 105

saving 17

transporting 106

X

XBehavior 129
XDyn 129

ConceptDraw

Y

YBehavior 130
YDyn 129

Z
Zooming 79

181



